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Preface

This publication contains installation and operating instructions for the IBM®

Tivoli® Storage Manager for Storage Area Networks.

Who should read this guide
This guide is for administrators who install and use the storage agent component
of the Tivoli Storage Manager for Storage Area Networks product (referred to as
the storage agent throughout this publication).

It provides:
v An overview of LAN-free data transfer
v Detailed explanations for installing, configuring, and using the Tivoli Storage

Manager client and storage agent, and the Tivoli Storage Manager server)

To use this guide, you must know:
v The operating system on which the server will be installed
v The devices that can use Tivoli Storage Manager
v The workstation operating systems on which the clients reside
v The communication protocols installed on your client and server systems
v Storage area network (SAN) administration

Publications
Publications for the Tivoli Storage Manager family of products are available online.
The Tivoli Storage Manager product family includes IBM Tivoli Storage
FlashCopy® Manager, IBM Tivoli Storage Manager for Space Management, IBM
Tivoli Storage Manager for Databases, and several other storage management
products from IBM Tivoli.

To search across all publications or to download PDF versions of individual
publications, go to the Tivoli Storage Manager information center at
http://pic.dhe.ibm.com/infocenter/tsminfo/v7r1.

You also can find the Tivoli Storage Manager product family information centers
and other information centers that contain official product documentation for
current and previous versions of Tivoli products at Tivoli Documentation Central.
Tivoli Documentation Central is available at http://www.ibm.com/
developerworks/community/wikis/home/wiki/Tivoli Documentation Central.
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Conventions used in this publication
Typographic conventions are used in Storage Agent User's Guide.

Command to be entered on the command line:
> dsmadmc

Command to be entered on the command line of an administrative client:
query devclass

Reading syntax diagrams
To read a syntax diagram for entering a command, follow the path of the line.
Read from left to right and from top to bottom.
v The ��─── symbol indicates the beginning of a syntax diagram.
v The ───� symbol at the end of a line indicates that the syntax diagram continues

onto the next line.
v The �─── symbol at the beginning of a line indicates that a syntax diagram

continues from the previous line.
v The ───�� symbol indicates the end of a syntax diagram.

Command names

The command name can consist of a single action word, such as HALT, or it can
consist of an action word and an object for the action, such as DEFINE DOMAIN.
You can enter the command in any column of the input line.

Enter the entire command name or the abbreviation that is specified in the syntax
diagram for the command. Uppercase letters denote the shortest acceptable
abbreviation. If a command appears entirely in uppercase letters, you cannot
abbreviate it. You can enter the command in uppercase letters, lowercase letters, or
any combination. In this example, you can enter CMDNA, CMDNAM, or
CMDNAME in any combination of uppercase and lowercase letters.

�� CMDNAme ��

Note: Command names in descriptive text are always capitalized.

Required parameters

When a parameter is on the same line as the command name, the parameter is
required. When two or more parameter values are in a stack and one of them is on
the line, you must specify one value.

In this example, you must enter PARMNAME=A, PARMNAME=B, or
PARMNAME=C. Do not include any blanks immediately before or after the equal
sign (=).

�� PARMName = A
B
C

��

x IBM Tivoli Storage Manager for SAN for Linux: Storage Agent User's Guide



Optional parameters

When a parameter is below the line, the parameter is optional. In this example,
you can enter PARMNAME=A or nothing at all. Do not include any blanks
immediately before or after the equal sign (=).

��
PARMName = A

��

When two or more parameter values are in a stack below the line, all of them are
optional. In this example, you can enter PARMNAME=A, PARMNAME=B,
PARMNAME=C, or nothing at all. Do not include any blanks immediately before
or after the equal sign (=).

��
PARMNAme = A

B
C

��

Defaults

Defaults are above the line. The system uses the default unless you override it. You
can override the default by entering an option from the stack below the line.

In this example, PARMNAME=A is the default. You can also enter
PARMNAME=A, PARMNAME=B, or PARMNAME=C. Do not include any blanks
before or after the equal sign (=).

��
PARMNAme = A

PARMName = A
B
C

��

Variables

Highlighted lowercase items (like this) denote variables. In these examples,
var_name represents variables::

�� CMDNAme var_name ��

��
PARMname = var_name

��

Special characters

You must code these symbols exactly as they appear in the syntax diagram.

* Asterisk

: Colon

, Comma
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= Equal sign

- Hyphen

( ) Parentheses

. Period

Repeating values

An arrow returning to the left means that the item can be repeated. A character
within the arrow means that you must separate repeated items with that character.

�� �

,

file_name ��

Repeatable choices

A stack of values followed by an arrow returning to the left means that you can
select more than one value or, when permitted, repeat a single item. In this
example, you can choose more than one value, with each name delimited with a
comma. Do not include any blanks before or after the equal sign (=).

�� �

,

PARMNAme = value1
value2
value3

��

Footnotes

Footnotes are enclosed in parentheses.

�� �

,
(1)

file_name ��

Notes:

1 You can specify up to five file names.

Entering parameters

The order in which you enter parameters can be important. The following example
shows a portion of the command for defining a copy storage pool:

�� DEFine STGpool pool_name device_class_name POoltype = COpy �

�
DESCription = description

REClaim = 100

REClaim = percent
��
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The first two parameters in this command (pool_name and device_class_name are
required parameters. pool_name and device_class_name are also positional. That is,
they must be entered in the order shown, immediately after the command name.
The POOLTYPE parameter is a required keyword parameter. DESCRIPTION and
RECLAIM, are optional keyword parameters. Keyword parameters are identified by
an equal sign that specifies a specific value or a variable. Keyword parameters
must follow any positional parameters in a command.

The following command entries, in which the keyword parameters are ordered
differently, are both acceptable:
define stgpool mycopypool mydeviceclass pooltype=copy description=engineering

reclaim=50
define stgpool mycopypool mydeviceclass description=engineering pooltype=copy

reclaim=50

The following example, in which one of the positional parameters follows a
keyword parameter, is not acceptable:
define stgpool mycopypool pooltype=copy mydeviceclass description=engineering

reclaim=50

Syntax fragments

Some diagrams, because of their length, must display parts of the syntax with
fragments. The fragment name appears between vertical bars in the diagram.

The expanded fragment appears in the diagram after all other parameters or at the
bottom of the diagram. A heading with the fragment name identifies the expanded
fragment. Commands appearing directly on the line are required.

In this example, the fragment is named “Fragment”.

�� Fragment ��

Fragment:

A

B
C

Syntax diagram descriptions
This topic covers syntax diagrams including descriptions and examples:

Abbreviations: Uppercase letters denote the shortest acceptable abbreviation. If an
item appears entirely in uppercase letters, you cannot abbreviate the item.

You can type the item in uppercase letters, lowercase letters, or any combination.
In this example, you can enter CMDNA, CMDNAM, or CMDNAME in any
combination of uppercase and lowercase letters.

�� CMDNAme ��
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Symbols: You must code these symbols exactly as they appear in the syntax
diagram.

* Asterisk

: Colon

, Comma

= Equal Sign

- Hyphen

( ) Parentheses

. Period

Variables: Highlighted lowercase items (like this) denote variables. In this example,
var_name represents a variable you must specify when you code the CMDNAME
command.

�� CMDNAme var_name ��

Repetition: An arrow returning to the left means that the item can be repeated. A
character within the arrow means that you must separate repeated items with that
character.

�� �

,

repeat ��

A footnote (1) by the arrow refers to a limit that tells how many times the item can
be repeated.

�� �

,
(1)

repeat ��

Notes:

1 Specify repeat up to 5 times.

Required Choices: When two or more items are in a stack and one of them is on
the line, you must specify one item.

In this example, you must choose CMDNAME=A, CMDNAME=B, or
CMDNAME=C. Do not include any blanks immediately before or after the equal
sign (=).

�� CMDNAme = A
B
C

��

Optional Choices: When an item is below the line, the item is optional. In this
example, you can choose CMDNAME=A or nothing at all. Do not include any
blanks immediately before or after the equal sign (=).
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��
CMDNAme = A

��

When two or more items are in a stack below the line, all of them are optional. In
this example, you can choose CMDNAME=A, CMDNAME=B, CMDNAME=C, or
nothing at all. Do not include any blanks immediately before or after the equal
sign (=).

��
CMDNAme = A

B
C

��

Defaults: Defaults are above the line. The system uses the default unless you
override it. You can override the default by coding an option from the stack below
the line.

In this example, CMDNAME=A is the default. You can also code CMDNAME=A,
CMDNAME=B, or CMDNAME=C. Do not include any blanks before or after the
equal sign (=).

��
CMDNAme = A

CMDNAme = A
B
C

��

Repeatable Choices: A stack of items followed by an arrow returning to the left
means that you can select more than one item or, in some cases, repeat a single
item. In this example, you can choose more than one value, with each name
delimited with a comma. Do not include any blanks before or after the equal sign
(=).

�� �

,

CMDNAme = value1
value2
value3

��

Syntax Fragments: Some diagrams, because of their length, must fragment the
syntax. The fragment name appears between vertical bars in the diagram.

The expanded fragment appears in the diagram after all other parameters or at the
bottom of the diagram. A heading with the fragment name identifies the expanded
fragment. Commands appearing directly on the line are required.

In this example, the fragment is named “Fragment”.

�� Fragment ��
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Fragment:

A

B
C
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New for Tivoli Storage Manager for Storage Area Networks
Version 7.1

IBM Tivoli Storage Manager for Storage Area Networks is updated for Version 7.1.

Deprecated device types

In Tivoli Storage Manager Version 7.1, certain device types are deprecated.
The following device types are deprecated. While you can use these device
types with Tivoli Storage Manager Version 7.1, plan to migrate data to new
devices before you upgrade to a later release of Tivoli Storage Manager.
v 3490
v 3570
v CARTRIDGE
v OPTICAL
v WORM
v QIC
v DTF

For a list of devices and valid device class formats, see the Tivoli Storage
Manager Supported Devices website for your operating system:

http://www.ibm.com/software/sysmgmt/products/support/
IBM_TSM_Supported_Devices_for_Linux.html
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Chapter 1. Storage agent overview

IBM Tivoli Storage Manager for Storage Area Networks allows client systems to
write data directly to, or read data directly from, storage devices that are attached
to a storage area network (SAN). This is called LAN-free data movement.

LAN-free data movement makes LAN bandwidth available for other uses and
decreases the load on the Tivoli Storage Manager server, allowing it to support a
greater number of concurrent client connections.

The key component of Tivoli Storage Manager for Storage Area Networks is the
storage agent. You install the storage agent on a client system that shares storage
resources with the Tivoli Storage Manager server, as shown in Figure 1.

As shown in Figure 2 on page 2, the storage agent can support several clients
while installed on only one of the clients. You can also install the storage agent on
a client system that does not share storage resources with the Tivoli Storage
Manager server, but that is connected to a client system that does share storage
resources. The LANFREECOMMMETHOD option allows a client system that
shares storage resources to communicate with the storage agent. The
LANFREECOMMMETHOD option also allows the storage agent to support several
clients while the storage agent is installed on only one of the clients.

Tape library
File library

Library control
client metadata

Library control

SAN

LAN

Tivoli Storage
Manager
server

Tivoli Storage Manager
backup-archive client

with storage agent
installed

Client data

Figure 1. SAN data movement. Solid lines indicate data movement. Broken lines indicate
movement of control information and metadata.
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A Tivoli Storage Manager server, acting as a library manager, controls the storage
devices. This server can be the server that is working with the storage agent or
another Tivoli Storage Manager server in the enterprise. The Tivoli Storage
Manager server tracks the metadata that the client has stored. The metadata, such
as policy information, and file name and size, is passed over the LAN connection
between the storage agent and server.

The storage agent communicates with the server to obtain and store database
information, and to coordinate device and volume access. The server and client
coordinate and transfer data access through the SAN. The client uses the storage
agent for operations where appropriate. For example, if a SAN path is defined, the
client (through the storage agent) transfers data using that path. If a failure occurs
on the SAN path, failover occurs and the client uses its LAN connection to the
Tivoli Storage Manager server and moves the client data over the LAN.

The storage agent can send the data directly to the server using the paths between
the storage agent and the server. An example is a LAN-free storage pool that is
updated to read-only after the client connects to the server and obtains its initial
policy information. The storage agent, instead of failing the operation, sends the
data to the server. If the storage hierarchy is configured so that the next storage
pool destination is available, the server runs the operation.

You can also prevent data from being transferred over the LAN by specifying the
Tivoli Storage Manager server parameters DATAREADPATH and
DATAWRITEPATH with the REGISTER NODE or UPDATE NODE commands for
a specific node. To review these settings, issue the following command on the
server for the node:
query node node_name format=detailed

Tivoli Storage Manager supports SAN-attached device sharing in the following
environments:
v Tivoli Storage Manager native library management support consisting of an

ACSLS, SCSI, or IBM 349X library manager and library clients or just a library
manager.

Tape library
File library

Library control
client metadata

Library control

SAN

LAN

Tivoli Storage
Manager
server

Client data

Client data

Backup-
archive client

Backup-archive
client with

storage agent
installed

Backup-
archive client

Figure 2. SAN data movement with the LANFREECOMMMETHOD option. Solid lines indicate
data movement. Broken lines indicate movement of control information and metadata.
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v Shared disk storage using a FILE library and the integration of IBM General
Parallel File System, or IBM TotalStorage SAN File System. General Parallel File
System is the preferred option for operating systems on which it is supported.

v External libraries. For a description of external libraries, see the Administrator's
Guide.

Related concepts:
“ACSLS, SCSI, VTL, and 349x tape-library sharing” on page 20
“File device sharing” on page 21
“External libraries” on page 22
Related information:

IBM General Parallel File System

TotalStorage SAN File System

LAN-free client-data backup: Scenario
Tape and file media to be used for client backup data is stored in a storage pool
that uses a device that is shared on a SAN. A library manager sends the location to
a storage agent. Backup data goes directly to the device over a SAN.

A typical scenario for LAN-free data movement consists of the following steps:
1. The backup-archive client begins a backup operation. The server reports policy

information to the client, including whether a destination is LAN-free. As the
client assigns policy settings for files during backup processing, it sends the
data, using LAN-free data movement, when the destination for that policy is
LAN-free enabled.
A storage pool is a LAN-free destination when the storage pool uses a device
that is shared on a SAN. That device must also have a defined path to the
storage agent.

2. The storage agent receives data for those files that are backed up by the client
and assigned to policy settings that use a LAN-free enabled storage pool. The
storage agent sends a request for a volume mount to the library manager
server. In external libraries, the storage agent contacts the external library
manager, using the path to the executable file.

3. A request is made to the storage device to mount the appropriate media.
4. The library manager notifies the storage agent of the location where the

mounted media resides. In external libraries, the storage agent is informed of
the device location by the external library manager.

5. The client, by use of the storage agent, writes the backup data directly to the
device over the SAN.

6. The storage agent sends metadata information to the Tivoli Storage Manager
server, and the server stores the information in its database.

Restriction: LAN-free data movement takes precedence over client-side data
deduplication. If LAN-free data movement occurs during client-side data
deduplication, client-side data deduplication is turned off, and a message is issued
in the error log.
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Multi-session no-query restore for LAN-free path: Scenario
When you start a no-query restore, the Tivoli Storage Manager server builds a list
of files to restore and sends data to the client while it builds the list. The restore
can therefore be restarted if it is interrupted.

Multiple sessions are used for the no-query restore when data for the restore is
stored on devices with a LAN-free path and devices with a LAN-only path. Some
sessions restore data from the server with a LAN-only path. The other sessions use
the storage agent to restore data over the LAN-free path.

The number of sessions that are used for a restore operation is dependent on the
value of the client RESOURCEUTILIZATION option and the number of server volumes
that contain the client data to be restored.

The following actions outline a typical multi-session no-query restore for a
LAN-free path:
1. The client requests a file space to be restored. This request is forwarded to the

server.
2. The server determines the files to restore and the volume on which those files

are stored. The server generates a list that is sorted by the volume name.
3. The client is informed of the progress and the number of volumes. The client

can start more sessions to restore the information.
4. The location of the volume, and whether the storage agent can access the

volume, determines how the data is handled. When the volume can be
mounted on a shared device that the storage agent can access, the data is read
from the volume by the storage agent and sent to the client. When the volume
cannot be mounted on a shared device that the storage agent can access, the
data is read from the volume by the server and sent directly to the client. The
client then begins additional sessions: some to the storage agent for the
volumes that are LAN-free enabled and some sessions to the server for those
volumes that are not LAN-free enabled.

The process repeats until all files in the list are restored.

Storage agent and z/OS media server overview
IBM Tivoli Storage Manager for z/OS® Media allows client systems, through a
storage agent, to communicate with storage devices attached to a z/OS system.

Data movement between the storage agent and the z/OS media server is not a
typical LAN-free data transfer. A storage agent that is installed on a client system
communicates with the z/OS media server through a LAN to complete storage
agent data transfer.

Tivoli Storage Manager for z/OS Media provides access to storage devices that are
attached to a z/OS system for Tivoli Storage Manager servers that run on specific
operating systems other than z/OS. Tivoli Storage Manager library support that
consists of a ZOSMEDIA library type enables access to z/OS attached devices. A
storage agent that is installed on a client system communicates with the Tivoli
Storage Manager server. The Tivoli Storage Manager for z/OS Media server allows
access to z/OS media through the storage agent. The storage agent is configured to
access the z/OS resources that are controlled by the z/OS media server. The Tivoli
Storage Manager server stores client metadata, such as file name and size, and also
stores volume and library name information that identifies where the data is
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stored. The z/OS media server stores the data.

Data movement in a z/OS media server environment: Scenario
A storage agent is configured to access z/OS storage resources that are controlled
by a z/OS media server. The storage agent that is installed on a client system
communicates with the z/OS media server over the LAN.

A typical scenario for storing or retrieving data between a storage agent and z/OS
media server storage consists of the following steps:
1. The storage agent initiates a data request with the Tivoli Storage Manager

server to determine whether a path exists to the z/OS media server.
2. The Tivoli Storage Manager server determines that a path does exist from the

storage agent to the z/OS media server.
3. The Tivoli Storage Manager server provides the storage agent with the z/OS

media server name from the library path definition, in addition to a volume
and library name. The storage agent uses the server name, volume name
(PRIVATE or SCRATCH), and library path definition to establish that it is
configured to access the z/OS media server. The storage agent determines the
IP address, port, and password for the z/OS media server from the Tivoli
Storage Manager server database.

4. The storage agent sends a request for a volume mount to the z/OS media
server, by using the IP address, port, and password.

5. The z/OS media server authenticates the connection, completes the volume
open request, and mounts the FILE or TAPE volume.

LAN

FICON

Tape library

Tivoli Storage
Manager
backup-

archive client

Storage
agent

Tivoli Storage
Manager server

z/OS
media
serverDB2

z/OS FICON
channel-attached

tape drives

Metadata

Client data

Client data

Figure 3. Data movement in a z/OS media server environment. Solid lines indicate data
movement. Solid lines with arrows indicate client data. Broken lines indicate movement of
control information and metadata.
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6. The client, through the storage agent, sends, or receives data to or from the
z/OS media server. The Tivoli Storage Manager server manages the storage
agent transaction.

7. The storage agent sends metadata information to the Tivoli Storage Manager
server, and the server stores the information in its database.
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Chapter 2. Planning for storage agent installation and
configuration

For optimal results, plan the installation and configuration of your system for
LAN-free data movement.

As part of your planning for LAN-free data movement, you must identify the
following items:
v Which environment to implement.
v The devices to be used for LAN-free data movement.
v The clients that use LAN-free data movement.
v The server that manages data of a particular client.
v The library that is used for the LAN-free enabled device. If the library is a Tivoli

Storage Manager shared library, you must identify the Tivoli Storage Manager
server that is the library manager. If the library is managed by Oracle StorageTek
Automated Cartridge System Library Software (ACSLS), you must identify the
control point. If the library is an external library, you must identify the external
library manager.

If you are planning to move data from a storage agent to a z/OS media server, you
must identify:
v The client the storage agent is installed on.
v The Tivoli Storage Manager server that manages access to the z/OS media

server.
v The z/OS media server and the devices on the z/OS system.
v The library paths from each storage agent to facilitate connectivity with the

z/OS media server.

Software requirements
IBM Tivoli Storage Manager for Storage Area Networks requires specific levels of
software.

You can find the most current information about the hardware and software
requirements for Tivoli Storage Manager for Storage Area Networks at
https://www.ibm.com/support/docview.wss?uid=swg21243309.
Related information:

IBM General Parallel File System

TotalStorage SAN File System
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Supported operating systems
You can use Tivoli Storage Manager for Storage Area Networks on IBM AIX®,
HP-UX, Linux, Oracle Solaris, and Microsoft Windows.

When you use a shared Automated Cartridge System Library Software (ACSLS)
library, the library manager must be a Tivoli Storage Manager server on AIX,
HP-UX, Linux, Solaris, or Windows.

In a z/OS media server environment, you can move data from a storage agent to a
z/OS media server only on the following platforms: AIX, Linux, Solaris, and
Windows.

For information about environments that the Linux storage agent supports, see
http://www.ibm.com/software/sysmgmt/products/support/
IBMTivoliStorageManager.html.

AIX operating system: The storage agent is available on 64-bit systems only.

Note:

HP-UX operating system: The HP-UX passthru device driver replaces the Tivoli
Storage Manager tsmscsi device driver and is packaged as part of the Tivoli
Storage Manager server. The passthru driver can be used with either HP-UX 11i
version 2 or version 3.

File sharing software
If you are sharing disk storage, IBM General Parallel File System (GPFS™), IBM, or
IBM TotalStorage SAN File System must be installed.

If you are sharing only tape devices, file-sharing software is not required.
Related information:

IBM General Parallel File System

TotalStorage SAN File System

Network requirements
You must ensure that your system meets the network requirements when you use
Tivoli Storage Manager for Storage Area Networks so that you can establish
communications between the client, storage agent, and Tivoli Storage Manager.
Through the storage agent, the Tivoli Storage Manager server can send and receive
data through LAN-free data movement.

Communications between the client, storage agent, and Tivoli
Storage Manager server

When you configure the storage agent, you establish communications between the
storage agent, the client, and the Tivoli Storage Manager server.

When you configure the client, storage agent, and server, keep in mind the
following rules:
v Client nodes that are eligible for LAN-free data movement must be registered on

the server. To register client nodes, use the REGISTER NODE command. The default
parameter is TYPE=CLIENT.
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v The client must point to the server and storage agent. Ensure that the following
options are configured correctly in the client system-options file:

Table 1. Options in the client system-options file

Option name Description

LANFREETCPSERVERADDRESS Specifies the TCP/IP address for the storage
agent.

LANFREETCPPORT Specifies the port on which the storage agent
listens.

LANFREECOMMMETHOD Specifies the communications protocol
between the Tivoli Storage Manager client
and storage agent.

LANFREESHMPORT You can use the LANFREESHMPORT option
when lanfreecommmethod=SHAREdmem is
specified for communication between the
Tivoli Storage Manager client and storage
agent.

LANFREESSL Specifies that the Tivoli Storage Manager
client enables Secure Sockets Layer (SSL)
when it communicates with the storage
agent.

TCPSERVERADDRESS Specifies the TCP/IP address for a Tivoli
Storage Manager server.

TCPPORT Specifies a TCP/IP port address for a Tivoli
Storage Manager server.

SSL Specifies that Secure Sockets Layer (SSL) is
enabled, to provide secure communication
between the storage agent, client, and server.

SSLRequired Specifies whether the client must use SSL.

Restriction: When a LAN-free path is enabled, the storage agent settings
override the client TCPSERVERADDRESS, TCPPORT, and SSL options. This override
action occurs to ensure that both the client and the storage agent use the same
server communication options.

v The server and the storage agent must point to each other:
– To point the server to the storage agent, use the DEFINE SERVER or UPDATE

SERVER command on the Tivoli Storage Manager.
– To point the storage agent to the Tivoli Storage Manager server, you must

configure the storage agent device configuration file and options file with the
name of Tivoli Storage Manager server. To configure, you can edit each of the
files manually or you can use the DSMSTA SETSTORAGESERVER command.

When you set up communication between the storage agent and the Tivoli
Storage Manager server, ensure that you are using the correct server name. Issue
the QUERY STATUS command to show the server name.

v Tivoli Storage Manager servers, clients, and storage agents, might be subject to
rules when you authenticate passwords with the Lightweight Directory Access
Protocol (LDAP) directory server. If nodes communicate with the storage agent
and authenticate through an LDAP directory server, the storage agent can be
configured to use Secure Sockets Layer (SSL). Passwords that are authenticated
with the LDAP directory server can provide enhanced system security. When
SSL is enabled, the Tivoli Storage Manager server and the storage agent
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communicate with each other using SSL. SSL is the default method of
communication when LDAP authentication is in use and is optional.

Important: Do not change the Tivoli Storage Manager Server SelfSigned SHA
Key and Tivoli Storage Manager Server SelfSigned Key label names when you
use storage agents. The label is the name of the certificate that is stored in the
Global Security Kit (GSKit) key database file. After you set up the storage agent
for SSL, do not alter the certificate label names.

Figure 4 shows how configuration connects the storage agent, client, and the Tivoli
Storage Manager server. Use this figure as a reference point when you install the
software on client systems, and when you define the storage agent and configuring
devices.

Requirement:

v The SERVERNAME option in the dsm.sys file, the client system-options file, must
match the SERVERNAME option in the dsm.opt file, the client user-options file.
However, the option is unrelated to and does not need to match the SERVERNAME
option that is defined for the storage agent in the storage-agent options file,
dsmsta.opt.

Related tasks:
“Verifying and updating client node information” on page 52
“Verifying and updating client node information” on page 30
“Verifying and updating client node information” on page 78
“Configuring a storage agent and server to use SSL” on page 61
“Configuring a storage agent and server to use SSL” on page 39

set servername tsmsrver

register node xxxxxx type=clientdataowner

servername server_c

enablelanfree yes

lanfreecommmethod tcpip

lanfreetcpport 1543

comm

tcpserveraddress

tcpport 1543

ssl yes

lanfreetcpserveraddress agent.example.com

method tcpip

tsmsrver.example.com

dsm.sys file

Tivoli Storage Manager server TSMSRVER

Storage agent STORAGNT
Backup-archive client DATAOWNER

define server serverpassword=tsm4mestoragnt

hladdress=agent.example.com

lladdress=1543 ssl=yes

dsmsta.opt file

bak2work domain=sandomain

devconfig.out file

set staname storagnt

set stapassword xxxxxxx

set stahladdress agent.example.com

define server serverpassword=xxxxxxxx

hladdress=tsmsrver.example.com

lladdress=1543 ssl=yes

tsmsrver

servername

devconfig

commmethod tcpip

tcpport 1500

ssltcpport 1543

stakeydbpw 2120f428eae07a932

tsmsrver

devconfig.out

Figure 4. Connections between the client, storage agent, and server. The passwords are
shown as xxxxxxx because they are encrypted in the file.
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Related reference:
“Storage agent options file” on page 102
“The device configuration file for the storage agent” on page 101
“DSMSTA SETSTORAGESERVER command” on page 107

Connecting the server, client, and storage agent with TCP/IP
TCP/IP is required for communication among the Tivoli Storage Manager server,
the client, and the storage agent. You can use Secure Sockets Layer (SSL) with
TCP/IP to ensure that passwords authenticated with the LDAP directory server are
secure between the Tivoli Storage Manager server and the storage agent.

The Tivoli Storage Manager storage agent can use TCP/IP Version 6 (IPv6) as its
communications protocol. IPv6 is interoperable with TCP/IP Version 4. You can
specify either IPv4 or both IPv4 and IPv6 as the value of the COMMMETHOD option
before you start the server, the backup-archive client, or the storage agent. The
same port numbers are used by the server, the backup-archive client, and storage
agent for both IPv4 and IPv6.

The server and storage agent use the COMMMETHOD V6TCPIP option to specify support
for both IPv4 and IPv6 simultaneously, depending on the protocols that are
configured on the system, on which the server or storage agent are located. As in
prior releases, COMMMETHOD TCPIP specifies that only IPv4 is used. When you
configure the storage agent by using the DSMSTA SETSTORAGESERVER command, use
addresses that correspond to the communications method used by the
backup-archive client. The backup-archive client supports either IPv4 or IPv6, but
not both at the same time. Other client components, such as CAD and web client,
use COMMMETHOD V6TCPIP to support both IPv4 and IPv6 simultaneously.

IPv6 address formats are acceptable for all functions that support IPv6. However, if
you use IPv6 addresses for the Shared Memory Protocol function, which does not
support IPv6, communications will fail. Continue to use IPv4 for Shared Memory
Protocol.

Interoperability between the Tivoli Storage Manager server, client, and
storage agent

You can use the Tivoli Storage Manager server and storage agent at different
releases. However, a Tivoli Storage Manager server must be at a level equal to or
higher than a storage agent level. For example, you can use a V6.3 Tivoli Storage
Manager server with a V6.2 storage agent. Tivoli Storage Manager provides
interoperability between the backup-archive client and the client application
programming interface (API). You can also an HSM client with a storage agent for
LAN-free data movement.

For more information about storage agent compatibility with different versions of
Tivoli Storage Manager, see http://www.ibm.com/support/
docview.wss?uid=swg21053218.

Clients and API

To enable LAN-free data movement, you must install a Tivoli Storage Manager
backup-archive client or a Tivoli Storage Manager Data Protection application
client on client systems.
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v For information about LAN-free requirements for data-protection clients, see the
Tivoli Storage Manager Data Protection documentation.

v For information about supported versions of the backup-archive client and client
API, see http://www.ibm.com/support/docview.wss?uid=swg21053218 .

v You can download the latest software levels from the Tivoli Storage Manager for
Storage Area Networks support website at http://www.ibm.com/support/
entry/portal/Overview/Software/Tivoli/
Tivoli_Storage_Manager_for_Storage_Area_Networks. The client API is packaged
with the backup-archive client.

Tivoli Storage Manager for Space Management

The HSM client on AIX GPFS, AIX JFS2, and Linux GPFS clients supports
LAN-free data transfer.

The SAN provides a path that allows migration and recall of data to and from a
SAN-attached storage device. Client data moves over the SAN to the storage
device by using the Tivoli Storage Manager storage agent. The Tivoli Storage
Manager storage agent must be installed on the same system as the client.

Server licensing and compatibility
To use LAN-free operations, you need a Tivoli Storage Manager server license. If
you use large libraries, you need a Tivoli Storage Manager Extended Edition
license.

To ensure compatibility between the storage agent and the server, check the
website for Tivoli Storage Manager storage agent and server compatibility at
http://www.ibm.com/support/docview.wss?uid=swg21302789.

To download the latest interim fix, see the IBM Tivoli Storage Manager for Storage
Area Networks support website at http://www.ibm.com/support/entry/portal/
Overview/Software/Tivoli/Tivoli_Storage_Manager_for_Storage_Area_Networks.

Planning for configuration
Planning the system configuration provides a smooth transition through system
setup and production.

Configuration work sheets for storage agent configuration
To be more efficient, obtain client-system and server-system information before you
install and configure the storage agent.

Client-system and server-system configuration work sheets
Work sheets help organize the information that you need to configure the storage
agent for LAN-free data movement.
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Client-system information:

Client-system information includes information about storage agents, client
communication protocols and ports, and devices.

Storage agent properties

Type of
information Description

Use this column to
record the values for
your environment

Storage agent
name

The name for the storage agent.

Storage agent
password

The password for the storage agent.

TCP/IP address The TCP/IP address of the storage agent.

TCP/IP port The TCP/IP port of the storage agent.

SSL port The SSL port for the storage agent.

SSL key database
password

The password for the key database file, if SSL
is used.

Client properties

Type of
information Description

Use this column to
record the values for
your environment

LAN-free
communications
protocol

The communications protocol between the
client and the storage agent. The following
protocols are available. Use the value in
parentheses as the value of the client
LANFREECOMMMETHOD option.

v TCP/IP Version 4 (TCPIP)

v TCP/IP Version 4 or Version 6 (V6TCPIP)

v Shared Memory (SHAREDMEM))

LAN-free port The TCP/IP or SSL port that is used for
LAN-free data movement. The type of
communication must match the configuration
of the storage agent. Use this value as the value
of the client LANFREETCPPORT option.

LANFREESSL
option

The option that specifies that the Tivoli Storage
Manager client enables Secure Sockets Layer
(SSL) when it communicates with the storage
agent.

SSLRequired
option

The option that specifies whether the client
must use SSL when it communicates with the
storage agent.

Tip: For details about the LANFREECOMMMETHOD option, see the Backup-Archive Clients
Installation and User's Guide.
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Device information

Table 2. External library environment

Type of
information Description

Use this column to
record the values for
your environment

Executable file
location

The fully qualified path to the
external-library-manager executable file for
each storage agent to which Tivoli Storage
Manager sends media-access requests.

Library name A 1- through 32-character name of your
choosing.

Table 3. ACSLS, 3494, or SCSI tape-library sharing environment

Type of
information Description

Use this column to
record the value or
values for your
environment

Device name The name of each tape drive for which you
will define a path.

Table 4. Shared disk environment

Type of
information Description

Use this column to
record the value for
your environment

Local path name The name of the local path to the
network-mounted file system (for example,
/shareddisk).

Related tasks:
“Obtaining device information” on page 18

Server-system information:

Server-system information includes information that the storage agent needs to
communicate with the Tivoli Storage Manager server. You also need information
about devices and client nodes.

To verify server information, use the QUERY STATUS command. You can issue the
command from a Tivoli Storage Manager administrative command-line client.

Server properties

Type of
information Description

Use this column to
record the values for
your environment

Name The name of the server.

Password The password for the server.

TCP/IP
address

The TCP/IP address for the server.

TCP/IP port The TCP/IP port for the server.

SSL port The SSL port for the server.
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Device information

Table 5. External library environment

Type of
information Description

Use this column to
record the values for
your environment

Executable file
location

The fully qualified path to the
external-library-manager executable file for each
storage agent to which Tivoli Storage Manager
can send media access requests.

Library name A 1- through 32-character name of your choosing.

Table 6. ACSLS, 3494, SCSI, or VTL library environment

Type of
information Description

Use this column to
record the values for
your environment

Library name The name of an ACSLS, 3494, SCSI, or VTL
library.

Table 7. Shared disk environment

Type of
information Description

Use this column to
record the value for
your environment

Local path name The name of the local path to the
network-mounted file system (for example,
/shareddisk).

Client node information

Type of
information Description

Use this column to
record the values for
your environment

Client node
names

The names of the client nodes on which you
will install and configure the storage agent. You
need this information when you register the
nodes, set the policy for them, and place any
needed restrictions on them.

Related tasks:
“Obtaining device information” on page 18
“Verifying and updating client node information” on page 52
“Verifying and updating client node information” on page 30
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Client-system and server-system configuration worksheets for
z/OS Media
Work sheets help organize the information that you need to configure the storage
agent for moving data to a z/OS media server.

Client-system information:

Client-system information includes information about storage agents, client
communication protocols and ports, and the z/OS media server.

Storage agent properties

Type of
information Description

Use this column to
record the values for
your environment

Storage agent
name

The name for the storage agent.

Storage agent
password

The password for the storage agent.

TCP/IP address The TCP/IP address of the storage agent.

TCP/IP port The TCP/IP port of the storage agent.

Client properties

Type of
information Description

Use this column to
record the values for
your environment

LAN-free
communications
protocol

The communications protocol between the
client and the storage agent. The following
protocols are available. Use the value in
parentheses as the value of the client
LANFREECOMMMETHOD option.

v TCP/IP Version 4 (TCPIP)

v TCP/IP Version 4 or Version 6 (V6TCPIP)

v Shared Memory (SHAREDMEM))

LAN-free port The TCP/IP port that is used for LAN-free data
movement. Use this value as the value of the
client LANFREETCPPORT option.

Tip: For details about the LANFREECOMMMETHOD option, see the Backup-Archive Clients
Installation and User's Guide.

z/OS media server information

Type of
information Description

Use this column to
record the values for
your environment

z/OS media
server Name

The name of each z/OS media server server.

z/OS media
server Password

The password for the z/OS media server
server.

TCP/IP address The TCP/IP address for the z/OS media
server.
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Type of
information Description

Use this column to
record the values for
your environment

TCP/IP port The TCP/IP port for the z/OS media server.

Related tasks:
“Obtaining device information” on page 18

Server-system information:

Server-system information includes information that the storage agent needs to
communicate with the Tivoli Storage Manager server and the z/OS media server.

To verify server information, use the QUERY STATUS command. You can issue the
command from a Tivoli Storage Manager administrative command-line client.

Server properties

Type of
information Description

Use this column to
record the values for
your environment

Name The name of the server.

Password The password for the server.

TCP/IP
address

The TCP/IP address for the server.

TCP/IP port The TCP/IP port for the server.

z/OS media server information

Type of
information Description

Use this column to
record the values for
your environment

z/OS media
server Name

The name of each z/OS media server server.

z/OS media
server Password

The password for the z/OS media server
server.

TCP/IP address The TCP/IP address for the z/OS media
server.

TCP/IP port The TCP/IP port for the z/OS media server.

Related tasks:
“Obtaining device information” on page 18
“Verifying and updating client node information” on page 78
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Obtaining device information
You use the device information from the storage agent when you define paths for
the server that functions as the library manager. If you are configuring a FILE
Library, you do not need to obtain device information.

About this task

Obtaining tape-device information in a Linux environment is different depending
on whether your environment supports IBM devices or non IBM devices.

For information about configuring Tivoli Storage Manager device drivers for
tape-drives and libraries, see the Administrator's Guide. Instructions are available for
configuring selected devices or all devices.
Related tasks:
“Preventing tape label overwrites” on page 45

Obtaining special file names for IBM tape devices:

Accessing IBM SCSI tape drives and libraries requires the IBM tape device driver.
After you install and loading the IBM tape device driver for your IBM SCSI tape
drives and libraries, a set of special file names are available for each device.

Procedure

View special file names by issuing the following command on the system where
the storage agent is installed:
ls /dev/IBM*

Results

The name for tape drives typically has the form /dev/IBMtapex, where x is a
number. The name for tape libraries typically has the form /dev/IBMchangerx,
where x is a number 0 - 255.

Obtaining the special file names of non-IBM tape devices:

Accessing non-IBM tape drives and libraries requires the Tivoli Storage Manager
Linux Passthru driver and the Linux SCSI generic driver. After these drivers are
installed, you can obtain special file names for the drives and libraries.

About this task

The Tivoli Storage Manager Linux Passthru driver replaces the Tivoli Storage
Manager Linux SCSI device driver in the device driver package (tsmscsi). This
Passthru driver runs on both Linux 2.4.x and 2.6.x kernels. The installation of the
Tivoli Storage Manager Linux Passthru driver is done with the installation of the
storage agent. You must install the Linux SCSI generic driver (sg) along with the
Linux operating system.

Procedure

Use the Tivoli Storage Manager Linux Passthru driver:
1. Verify that the device is connected to your system and active.
2. Verify that the device is correctly detected by your system by issuing the

following command:
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cat /proc/scsi/scsi

3. Ensure that both the Tivoli Storage Manager device driver package (tsmscsi)
and the storage agent package are installed.

4. Run the configuration method that you prefer (autoconf or tsmscsi) for the
Tivoli Storage Manager Passthru driver. Both methods are available in the
Tivoli Storage Manager device driver package and both methods perform the
following tasks:
v Load the Linux SCSI generic driver (sg) to the kernel.
v Create necessary files for the Passthru driver.
v Create device information files for libraries (/dev/tsmscsi/lbinfo) and tape

devices (/dev/tsmscsi/mtinfo).
v To run the autoconf configuration method, issue the following command

from the directory where the TIVsm-tsmscsi package is installed:
autoconf

v To run the tsmscsi configuration method:
a. Copy the two sample configuration files to the installation directory

(/opt/tivoli/tsm/devices/bin) from lb.conf.smp and mt.conf.smp to
lb.conf and mt.conf, respectively.

b. Edit the lb.conf and mt.conf files. Add one stanza (as shown in the
example at the start of the file) for each SCSI target, ID, and LUN
combination. Each combination of SCSI target, ID, and LUN entries
correspond to a tape drive or library you want configured. Make sure
that the files meet these requirements:
– The example that is located at the start of the files must be removed.
– There must be a new line between each stanza.
– There must be one new line after the last stanza.
– A number sign (#) must not exist in either file.

c. Run the tsmscsi script from the device driver installation directory.
5. Verify that the device is configured properly by viewing the text files for

libraries (/dev/tsmscsi/lbinfo) and tape devices (/dev/tsmscsi/mtinfo).
6. Determine the special file names for the tape drives and libraries:

v To determine the names for the tape drives, issue the following command:
ls /dev/tsmscsi/mt*

v To determine the names for the libraries issue the following command:
ls /dev/tsmscsi/lb*

Storage devices and the configuration of your environment
The type of storage device you use for LAN-free data storage determines how to
configure your environment.

As part of the configuration of your environment, you must identify one of the
following types of storage device you use:
v Automated Cartridge System Library Software (ACSLS), Small Computer System

Interface (SCSI), virtual tape library (VTL), and 349x tape-library sharing
v File device sharing by using IBM General Parallel File System (GPFS)
v External libraries
v Tivoli Storage Manager for z/OS Media storage
Related tasks:
“Preventing tape label overwrites” on page 45
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ACSLS, SCSI, VTL, and 349x tape-library sharing
When Tivoli Storage Manager servers share an ACSLS, SCSI tape, virtual tape
library (VTL), or 349x tape library device, one server, the library manager owns, and
controls the device.

The library manager operations include checking volumes into and out of the
library, labeling volumes, mounting and dismounting volumes, auditing volumes,
and tracking an inventory of library contents. The storage agents, along with other
Tivoli Storage Manager servers that share this library are library clients. As a library
client, the storage agent stores data and requests drives, tapes, and volumes.

When the Tivoli Storage Manager server is also the library manager for the devices
where data is stored by the storage agent, the storage agent communicates requests
to this Tivoli Storage Manager server. When the Tivoli Storage Manager server is
another library client, the storage agent communicates requests for itself or the
metadata server directly to the library manager.

The library manager server can support library clients that are at the same or
earlier version as the library manager. Library clients at a higher version than the
library manager are not supported. When you use a shared ACSLS library, the
library manager must be a Tivoli Storage Manager server on a AIX, HP-UX, Linux,
Solaris, or Windows operating system.

Note: If you define a library manager server that is shared with the Tivoli Storage
Manager server, the SANDISCOVERY option must be set to ON. By default, this option
is set to OFF.

A library client requests shared library resources, such as drives or media, from the
library manager, but uses the resources independently. The library manager
coordinates the access to these resources. Data moves over the SAN between the
storage device and either the library manager or the library client. Either the
library manager or any library client can manage the LAN-free movement of client
data when the client system includes a storage agent.

In this library-sharing environment, the most important relationship is the one
between the server and the storage agent. The server, working with the storage
agent, manages the storage hierarchy. The server could be a library client or library
manager. The server is responsible for the following operations:
v Migrations
v Expiration of files that is based on policy information
v Reclamation of free space on volumes and consolidation of the volumes
v Disaster recovery

The storage agent contributes information to the storage hierarchy through various
operations, but this role is independent of the library-sharing role.

The following library manager and library client configurations are represented in
Figure 5 on page 21:
v A Tivoli Storage Manager server library manager manages data of a client,

which is stored in a tape library.
v A Tivoli Storage Manager server library client manages data of a client, which is

stored in a tape library.
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Tips:

v An environment can have a library manager without a library client.
v In an environment where ACSLS library support is required, the library client

and library manager can be on a Tivoli Storage Manager server on AIX, HP-UX,
Linux, Solaris, or Windows.

File device sharing
When Tivoli Storage Manager servers share access to disk storage, the environment
contains a shared FILE device class and uses file-sharing software.

Note: IBM General Parallel File System is the preferred option for the operating
systems on which it is supported. All servers and storage agents must have access
to the same General Parallel File System storage. Enable the instance user IDs for
the server and the user ID for the storage agents to access the General Parallel File
System storage. For more information about setting up user ID mapping in a
mixed Windows or UNIX environment, see General Parallel File System
documentation.
Related information:

IBM General Parallel File System

TotalStorage SAN File System
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Tivoli Storage
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backup-archive
clients with

storage agents
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Tivoli Storage
Manager
server acting as a
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Tivoli Storage
Manager
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Figure 5. Library manager and client LAN-free configuration
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External libraries
If you cannot use a Tivoli Storage Manager native library (SCSI, 349x, ACSLS, and
virtual tape library), configure external library support.

A typical external library configuration includes an external library manager such
as the IBM Enterprise Removable Media Manager.

The Oracle StorageTek Automated Cartridge System Library Software (ACSLS)
server or LibraryStation on z/OS manages the physical aspects of tape cartridge
storage and retrieval. See Figure 6. The external library manager communicates
with the ACSLS server or LibraryStation on z/OS to access tape cartridges in an
automated Oracle StorageTek library. The storage agent is installed on a system
that contains the external library manager and a Tivoli Storage Manager
backup-archive client or a Tivoli Storage Manager data protection application
client. This configuration provides access to SAN-attached storage devices by using
LAN-free data movement. The continued connection to the LAN provides a
metadata (control information) path. If the storage agent is not available, the SAN
provides a failover path for data backup and recovery.
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Figure 6. ACSLS library environment
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If you have data that is associated with the Tivoli Storage Manager ACSLS library
type and want to take advantage of LAN-free data movement, you must consider
coexistence and migration issues.

If you stored data by using external library support for ACSLS library access and
plan to migrate to a native Tivoli Storage Manager library-sharing environment,
see the Administrator's Guide.
Related concepts:
“ACSLS legacy data migration and coexistence” on page 98

Tivoli Storage Manager for z/OS Media storage devices
Tivoli Storage Manager for z/OS Media provides access to storage devices, such as
tape device types and FILE device types that are attached to a z/OS media server.

The following table lists the supported devices and examples of Tivoli Storage
Manager device types:

Table 8. Device types

Device Device Type

Tape (real and virtual) 3590, 3592, ECARTRIDGE

VSAM (Virtual Sequential Access Method)
Linear Data Set (LDS)

FILE

If a Virtual Tape Library (VTL) has device characteristics of IBM 3590 recording
technology, the storage resources can be accessed through the z/OS media server
by the 3590 device type.

Encryption support
Encryption provides security and protects sensitive data on tape media.

With Tivoli Storage Manager for Storage Area Networks, you can use encryption
with the following drives:
v IBM and HP LTO-4 or later
v IBM 3592 generation 2 and later
v IBM TS1120 generation and later
v Oracle StorageTek T10000B
v Oracle StorageTek T10000C

You can also use client-side encryption and the Tivoli Storage Manager
automatically generated password.

When LTO-4 encryption is enabled, Tivoli Storage Manager manages data
encryption and decryption according to specifications set when you define the LTO
device class. To enable drive encryption with IBM LTO-4, you must have the IBM
RMSS Ultrium device driver installed. IBM LTO-4 SCSI drives do not support
encryption.
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Validation of data during tape read/write operations
To validate data and identify data that is corrupted, you can use logical block
protection. With logical block protection, you can identify errors that occur while
data is being written to tape and while data is transferred from the tape drive to
the Tivoli Storage Manager server through the storage area network.

Logical block protection is supported only with the following types of drives and
media:
v LTO5-drives and later
v IBM 3592 generation 2 and later
v IBM TS1120 generation and later
v Oracle StorageTek T10000C drives

For more information about logical block protection, see the Administrator's Guide.

Concurrent access to volumes in storage pools associated with
the FILE device type
Concurrent access improves restore performance. Two or more client sessions, two
or more storage agents, or a combination of client sessions and storage agents can
access the same volume at the same time.

Multiple client sessions and storage agents can read a FILE volume concurrently. In
addition, one client session or storage agent can write to the volume while it is
being read. FILE volumes provide the following benefits:
v You can reduce the potential for performance degradation when you back up or

archive to FILE volumes.
v You can control the size of FILE volumes by specifying a maximum capacity.
v You can control the number of concurrently open file volumes.

Access to client-side deduplicated data by using LAN-free
data movement

Only V6.2 or later storage agents can use LAN-free data movement to access
storage pools that contain data that was deduplicated by clients. V6.1 or earlier
storage agents cannot use LAN-free data movement to access these storage pools.

Using a V6.1 storage agent or earlier to access a storage pool that contains
client-side deduplicated data causes restore operations and retrieve operations to
use the LAN. See Table 9.

Table 9. Paths for data movement

Storage pool
contains only

client-side
deduplicated data

Storage pool
contains a mixture of

client-side and
server-side

deduplicated data

Storage pool
contains only

server-side
deduplicated data

V6.1 or earlier
storage agent

Over the LAN Over the LAN LAN-free

V6.2 or later storage
agent

LAN-free LAN-free LAN-free
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V6.2 or later backup-archive clients are compatible with V6.2 or later storage
agents, and provide LAN-free access to storage pools that contain client-side
deduplicated data.

As part of the planning process, decide whether you want to use LAN-free data
movement and whether you want to use client-side data deduplication, server-side
deduplication, or both. If you decide to use LAN-free data movement and both
client-side and server-side data deduplication, complete one of the following steps:
v For V6.1 or earlier storage agents, store client-side deduplicated data in a

separate storage pool. Restore and retrieve deduplicated data from this storage
pool over the LAN. Use LAN-free data movement to restore and retrieve data
from storage pools that contain data that was deduplicated only by the server.

v Upgrade to V6.2 or later storage agents. Upgrading to V6.2 or later storage
agents provides LAN-free access to any storage pool that contains client-side
deduplicated data, server-side deduplicated data, or both.
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Chapter 3. Installing and configuring tape-library and
file-device-sharing environments

The destination for LAN-free data can be tape media or sequential-access disk
media. Configuration requirements vary depending upon the type of environment.

Before you begin

Before you install and configure the tape-library and file-device-sharing
environments, verify that you completed the following actions:
v Make sure that you understand the overall installation and configuration

process, which takes place on different systems at different times.
v Be sure that you have the information that is recorded in the

configuration-information worksheets.

About this task

The major installation and configuration steps are:
1. “Establishing network connections”
2. “Installing and configuring software on client systems” on page 28
3. “Configuring the devices on the server” on page 38
4. “Defining paths from the storage agent to drives” on page 42
5. “Verifying the LAN-free configuration” on page 46
6. “Determining whether the data movement was LAN-free” on page 47
Related reference:
“Configuration work sheets for storage agent configuration” on page 12

Establishing network connections
Tivoli Storage Manager for storage area networks requires specific levels and
models of hardware and software. You must ensure that your system meets these
requirements.

Procedure

Establish network connections by completing the following steps:
1. Attach the server system and the client systems to the LAN and to the SAN

along with appropriate storage devices.
2. Optional: If you are planning to use a storage agent with disk media, install

IBM General Parallel File System, or IBM TotalStorage SAN File System on the
applicable systems.

Related concepts:
“File device sharing” on page 21
Related information:

Tivoli Storage Manager for Storage Area Networks support

IBM General Parallel File System

TotalStorage SAN File System
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Installing and configuring software on client systems
You install storage agents and backup-archive or Tivoli Storage Manager Data
Protection clients on client systems. If you install a Data Protection application
client, you must also install the Tivoli Storage Manager API.

About this task

Install and configure the software by completing the following tasks:
1. “Installing and configuring the client”
2. Only Data Protection application clients: “Installing and configuring the API”

on page 31
3. “Installing the storage agent” on page 32
4. “Configuring the storage agent” on page 37
Related concepts:
“Communications between the client, storage agent, and Tivoli Storage Manager
server” on page 8
Related tasks:
“Verifying and updating client node information” on page 52
“Verifying and updating client node information” on page 30
“Verifying and updating client node information” on page 78

Installing and configuring the client
The client can be a Tivoli Storage Manager backup-archive client or a Tivoli
Storage Manager Data Protection application client.

Before you begin

Before you install and configure the client, you must complete the following steps:
v Verify that the client system meets the prerequisites for client software. To

ensure software compatibility, check the website for Tivoli Storage Manager
storage agent and backup-archive client compatibility. You can download the
latest software levels from http://www.ibm.com/support/entry/portal/
Overview/Software/Tivoli/Tivoli_Storage_Manager.
For details about installing a backup-archive client, see the Backup-Archive Clients
Installation and User's Guide. For details about installing a Data Protection
application client, see the Data Protection Installation and Users Guides.

v Ensure that you completed the configuration worksheets.
v Ensure that client nodes are registered and configured on the server. To register

client nodes, use the REGISTER NODE or UPDATE NODE command.

Requirement: If multiple clients are using LAN-free data movement, install or
upgrade the client software on each client system.

Procedure

Install and configure the client by completing the following steps:
1. Install or upgrade the backup-archive client software or Data Protection

application-client software.
2. Using the information that you collected in the configuration worksheets,

modify the following file:
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v dsm.sys client system-options file

Tip: The file can be in one of several places, such as the installation directory,
or in a location pointed to by an environment variable.
Specify the communication method to be used between the client and server.

Table 10. Communications methods

To use this communication
method Install this software

To connect to these Tivoli
Storage Manager servers

TCP/IP TCP/IP (standard with
supported operating
systems)

AIX, HP-UX, Linux x86_64,
Linux on System z,
POWER®, Solaris, Windows
Server

Shared memory TCP/IP (standard with
platforms)

Linux x86_64, Linux on
System z, Linux on Power
Systems

For example:
commmethod tcpip
tcpserveraddress server_c.example.com
tcpport 1502

The preceding example uses a TCPPORT of 1502. However, the default TCPPORT is
1500.
Do not close the file.

Remember: The backup-archive client SERVERNAME option is not related to the
storage agent SERVERNAME option. For details, see the Backup-Archive Clients
Installation and User's Guide.

3. Add the following options to the same stanza in the same file that you edited
in step 2 on page 28. These options specify that the client uses SAN-attached
devices, when the path is available, during backup, restore, archive, and
retrieve processing.
enablelanfree yes
lanfreecommmethod tcpip
lanfreetcpserveraddress agent.example.com
lanfreetcpport 1500

or
enablelanfree yes
lanfreecommmethod SharedMem
lanfreeshmport 1510

What to do next

If you installed a Data Protection application client, you must install and configure
the Tivoli Storage Manager client API.
Related concepts:
“Communications between the client, storage agent, and Tivoli Storage Manager
server” on page 8
Related tasks:
“Verifying and updating client node information” on page 52
“Verifying and updating client node information” on page 30
“Verifying and updating client node information” on page 78
Related reference:
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“Client-system and server-system configuration work sheets” on page 12
Related information:

Tivoli Storage Manager for Storage Area Networks support

Storage agent and client compatibility with Tivoli Storage Manager servers

Tivoli Storage Manager support

Verifying and updating client node information
When you configure LAN-free data movement, you must register client nodes and
provide policy information about client nodes. You can also restrict when a client
node uses a LAN-free path.

Procedure

Verify client node information by completing the following steps:
1. Identify the client node or nodes that use the storage agent. In a typical

environment, a storage agent is used only by the client node that is on the
same system as the storage agent. However, you can configure two or more
client nodes to use the same storage agent.

2. Verify that the nodes are registered. If they are not registered, you must register
them. For details, see the Administrator's Guide.

3. Verify the policy information for the nodes. The copy group for backup and
archive must point to a storage pool that has a LAN-free path for a particular
storage agent. You define drive LAN-free paths and make them available for
the storage pool. To view the destinations that are capable of LAN-free data
movement, you can issue the VALIDATE LANFREE command on the server. For
details about this command, see the Administrator's Reference.

4. After you verify the registration and policy information for the nodes, you can
place restrictions on when a node can use the LAN-free path. The node
attributes DATAWRITEPATH and DATAREADPATH determine the restriction that is
placed on the node:
v To use only the LAN-free path on backup and archive operations, specify

DATAWRITEPATH.

Important: Backup and archive operations can fail if the LAN-free path is
unavailable.

v To use the LAN path on restore and retrieve operations, specify
DATAREADPATH.

For more information about commands and their attributes, see the
Administrator's Reference.

Related tasks:
“Configuring multiple clients to use the same storage agent” on page 97
“Using LAN and LAN-free paths in the same backup operation” on page 97
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Installing and configuring the API
If you are using a Tivoli Storage Manager Data Protection application client, you
must install and configure the Tivoli Storage Manager API.

Before you begin

Before you install and configure the API, verify that the client system meets the
prerequisites for the application programming interface (API) software. You can
download the latest software levels from the Tivoli Storage Manager product
support website.

For details about installing the API software, see the Backup-Archive Clients
Installation and User's Guide.

Requirement: If multiple Data Protection application clients are using LAN-free
data movement, configure the API on each client system.

Procedure
1. Install the Tivoli Storage Manager client API.
2. Specify the environment variables. The Tivoli Storage Manager API uses unique

environment variables to locate files.
v DSMI_CONFIG is the fully qualified name for the client user option file.
v DSMI_DIR points to the path that contains dsm.sys, dsmtca, and the

subdirectory en_US.
v en_US subdirectory must contain dsmclientV3.cat.
v DSMI_LOG points to the path for the dsierror.log file.

Tip: The quickest method to set the environment variables is to add these
variables to the user profile file.
The following examples show how to set up these environment variables in the
user profile:
export dsmi_config=/opt/tivoli/tsm/client/api/bin/dsm.opt
export dsmi_dir=/opt/tivoli/tsm/client/api/bin
export dsmi_log=/home/user_a/logdir

3. Edit an existing stanza or create a stanza in the dsm.sys file to specify the
communications options between the Tivoli Storage Manager API and server.
For example:
servername server_c
commmethod tcpip
enablelanfree yes
lanfreecommmethod tcpip
lanfreetcpserveraddress test.example.com
lanfreetcpport 1500
tcpport 1502
tcpserveraddress server_c.example.com

The example uses a TCPPORT of 1502. However, the default TCPPORT is 1500.
If a dsm.sys file does not exist in the directory that is specified by DSMI_DIR,
create a symbolic link to the dsm.sys file in the Tivoli Storage Manager client
installation directory. For example:
ln -s /opt/tivoli/tsm/client/ba/bin/dsm.sys

/opt/tivoli/tsm/client/api/bin/dsm.sys

Related reference:
“Client-system and server-system configuration work sheets” on page 12
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Related information:

Tivoli Storage Manager for Storage Area Networks support

Storage agent and client compatibility with Tivoli Storage Manager servers

Tivoli Storage Manager support

Installing the storage agent
The storage agent can be found in the Tivoli Storage Manager installation package.
You can obtain the installation package from the product DVD or from an IBM
download site.

Before you begin

If you plan to download the files, set the system user limit for maximum file size
to unlimited to ensure that the files can be downloaded correctly.
1. To query the maximum file size value, issue the following command:

ulimit -Hf

2. If the system user limit for maximum file size is not set to unlimited, change it
to unlimited by following the instructions in the documentation for your
operating system.

About this task

If you obtain the package from the product DVD, ensure that the installation files
are visible on the DVD drive.

If you obtain the package from an IBM download site, you must extract the
installation files.

Procedure
1. Download the appropriate package file from one of the following websites, or

you can access the files from the product DVD:
v For a first time installation or a new release go to Passport Advantage® at:

http://www.ibm.com/software/lotus/passportadvantage/. Passport
Advantage is the only site that you can download a licensed package file
from.

v For the latest information, updates, and maintenance fixes, go to the Tivoli
Storage Manager support site: http://www.ibm.com/support/entry/portal/
Overview/Software/Tivoli/Tivoli_Storage_Manager.

2. If you download the package from one of the download sites, complete the
following steps:
a. Verify that you have enough space to store the installation files when they

are extracted from the product package.
b. Download the package file to the directory of your choice. The path must

contain no more than 128 characters. Be sure to extract the installation files
to an empty directory. Do not extract to a directory that contains previously
extracted files, or any other files.
Also, ensure that you have executable permission for the package file.

c. If necessary, change the file permissions by issuing the following command:
chmod a+x package_name.bin

d. Issue the following command to extract the installation files:
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./package_name.bin

where package_name is like the following example:
7.1.0.000-TIV-TSMSRV-LinuxX64.bin
7.1.0.000-TIV-TSMSRV-LinuxS390X.bin

3. Select one of the following methods of installing the storage agent from the
Tivoli Storage Manager installation package:
v “Installing the storage agent by using the installation wizard” on page 55
v “Installing the storage agent by using console mode” on page 56
v “Installing the storage agent in silent mode” on page 57

Related reference:
“DSMSTA SETSTORAGESERVER command” on page 107

Installing the storage agent by using the installation wizard
You can install or update the storage agent by using the IBM Installation Manager
graphical wizard.

Before you begin

Ensure that you review the following important information about installing:
v Verify that the operating system is set to the language that you require. By

default, the language of the operating system is the language of the installation
wizard.

On test servers only: Use the following command to bypass prerequisite checks
such as the operating system and the required memory. Do not issue this
command on a production server.
./install.sh -g -vmargs "-DBYPASS_TSM_REQ_CHECKS=true"

Procedure

Choose whether to install from a downloaded package file, or from the DVD, and
complete the following steps to begin the installation:

Option Description

Installing from a downloaded package file: 1. Change to the directory where you
downloaded the package file.

2. Start the graphical interface installation
wizard by issuing the following
command:

./install.sh

Installing from DVD media: 1. Insert the DVD into the DVD drive.
Tip: Ensure that the installation files are
visible on the DVD drive.

2. Start the graphical interface installation
wizard by issuing the following
command:

./install.sh
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What to do next
v If errors occur during the installation process, these errors are recorded in log

files that are stored in the IBM Installation Manager logs directory.
You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

Related concepts:
“Software requirements” on page 7
Related information:

Tivoli Storage Manager for Storage Area Networks support

Passport Advantage download document

Installing the storage agent by using console mode
You can install or update the storage agent by using the command line in console
mode.

Before you begin

Ensure that you review the following important information about installing:
v Verify that the operating system is set to the language that you require. By

default, the language of the operating system is the language of the installation
wizard.

On test servers only: Use the following command to bypass prerequisite checks
such as the operating system and the required memory. Do not issue this
command on a production server.
./install.sh -c -vmargs "-DBYPASS_TSM_REQ_CHECKS=true"

Procedure

Choose whether to install from a downloaded package file, or from the DVD, and
complete the following steps to begin the installation:

Option Description

Installing from a downloaded package file: 1. Change to the directory where you
downloaded the package file.

2. Start the installation wizard in console
mode, by issuing the following
command:

./install.sh -c

You can generate a response file as part
of a console mode installation. Complete
the console mode installation options,
and in the Summary panel, specify G to
generate the responses.
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Option Description

Installing from DVD media: 1. Insert the DVD into the DVD drive.
Tip: Ensure that the installation files are
visible on the DVD drive.

2. Start the installation wizard in console
mode, by issuing the following
command:

./install.sh -c

You can generate a response file as part
of a console mode installation. Complete
the console mode installation options,
and in the Summary panel, specify G to
generate the responses.

What to do next
v If errors occur during the installation process, these errors are recorded in log

files that are stored in the IBM Installation Manager logs directory.
You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

Related concepts:
“Software requirements” on page 7
Related information:

Tivoli Storage Manager for Storage Area Networks support

Passport Advantage download document

Installing the storage agent in silent mode
You can install or update the storage agent in silent mode without any user
interaction.

Before you begin

A silent installation can use response files for data input. The following sample
response files are provided for installing, updating, and uninstalling Tivoli Storage
Manager:
v install_response_sample.xml

v update_response_sample.xml

v uninstall_response_sample.xml

If you want to use one of the sample response files, they can be found after you
extract the package files, in the input subdirectory. You can use these sample files
as they are or you can customize them to suit your needs. It is optimal to use the
sample response files. These sample files contain instructions and default values to
help you avoid any unnecessary warnings.

On test servers only: Use the following command to bypass prerequisite checks
such as the operating system and the required memory. Do not issue this
command on a production server.

./install.sh -s -acceptLicense -vmargs "-DBYPASS_TSM_REQ_CHECKS=true"
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Procedure
1. Create a response file, or use one of the sample response files such as

install_response_sample.xml or update_response_sample.xml.
2. To start the silent installation, issue one of the following commands from the

directory where the installation package file is extracted:

Option Description

Installing from a
downloaded package file or
DVD media:

To start the installation by accepting the default values,
issue the following command:

./install.sh -s -acceptLicense

To start the installation with a custom response file, issue
the following command, where response_file represents the
response file path, including the file name:

./install.sh -s -input response_file -acceptLicense

What to do next
v If errors occur during the installation process, these errors are recorded in log

files that are stored in the IBM Installation Manager logs directory.
You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

Related concepts:
“Software requirements” on page 7
Related information:

Tivoli Storage Manager for Storage Area Networks support

Passport Advantage download document

Defining and configuring the storage agent
You must define and configure the storage agent to communicate with the
backup-archive client and the Tivoli Storage Manager server.

Defining storage agents to the Tivoli Storage Manager server
For each client that uses LAN-free data transfer, you must define the client's
storage agent to the server.

Before you begin

Use the same name and password that you specified for the storage agent when
you installed it on the client system.

Procedure

Define storage agents to the server by completing the following steps:
1. Define the storage agent by issuing the DEFINE SERVER command from the

Tivoli Storage Manager server (library manager or library client) that will
manage the client's data.
define server storagnt serverpassword=fun4me
hladdress=agent.tucson.ibm.com lladdress=1502 ssl=yes

In the preceding example, the SSL parameter specifies that SSL communication
is used. If you specify SSL as the communication method, you must import SSL
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certificates from the server to the storage agent, and from the storage agent to
the server. Import SSL certificates before you start the storage agent or the
server.

2. Verify that the storage agent is defined to the library manager by issuing the
following command from the library-manager server:
query server server_name format=detailed

Important: If the library-manager server is different from the library-client
server that hosts the storage agent, define the storage agent as a server on both
the library-manager server and the library-client server. The storage agent must
be able to contact the library manager directly when it sends mount requests. If
the storage agent is only defined to the library client, it attempts to use
information from the library client to define itself to the library manager.

What to do next

When the storage agent is defined to the server, you can complete the steps in
“Configuring the storage agent.”

Configuring the storage agent
After the installation is completed, to ensure communication with the
backup-archive client and the Tivoli Storage Manager server, you must configure
the storage agent.

Before you begin
v Ensure that you complete the steps in “Defining storage agents to the Tivoli

Storage Manager server” on page 58.
v Use the information that you collected in the configuration worksheets.

Procedure

Configure the storage agent by completing the following steps:
1. Point the server to the storage agent by issuing the DEFINE SERVER command on

the Tivoli Storage Manager server.
2. Ensure that the DEVCONFIG option is specified in the storage agent options file

dsmsta.opt.
For example, for a device configuration file named devconfig.out, edit the
dsmsta.opt file by typing the following line:
DEVCONFIG devconfig.out

The device configuration file is in the following directory:
/opt/tivoli/tsm/StorageAgent/bin

3. Initialize the storage agent and add communication information by issuing the
DSMSTA SETSTORAGESERVER command. For example:
dsmsta setstorageserver myname=storagnt mypassword=fun4me
myhladdress=agent.example.com
servername=tsmsrver serverpassword=not4u
hladdress=tsmsrver.example.com lladdress=1502

Requirements:

v The SERVERNAME option in the dsm.sys file, which is the client system options
file, must match the SERVERNAME option in the dsm.opt file, which is the client
user-options file. However, the option is unrelated to and does not need to
match the SERVERNAME option that is defined for the storage agent in the
storage-agent options file, dsmsta.opt.
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v The HLADDRESS option must match the TCPSERVERADDRESS option that is in the
dsm.sys file on the Tivoli Storage Manager client. When you configure the
storage agent by using the DSMSTA SETSTORAGESERVER command, use
addresses that correspond to the communications method that is used by the
backup-archive client. With the backup-archive client, you can use either IPv4
(COMMMETHOD TCPIP option) or IPv6 (COMMMETHOD V6TCPIP option), but not
both.

v To secure communication between the storage agent and the Tivoli Storage
Manager server, ensure that your data is protected by Secure Sockets Layer
(SSL).

The DSMSTA SETSTORAGESERVER command generates the following output in the
storage agent device configuration file:
set staname storagnt
set stapassword xxxxxxx
set stahladdress agent.example.com
define server tsmsrver serverpassword=xxxxxxxxxxx
hladdress=tsmsrver.example.com lladdress=1502

In the preceding example, the passwords are encrypted.
The command also generates the following line in the dsmsta.opt file:
SERVERNAME tsmsrver

Related reference:
“Client-system and server-system configuration work sheets” on page 12
“Storage agent options file” on page 102
“DSMSTA SETSTORAGESERVER command” on page 107
“The device configuration file for the storage agent” on page 101
Related information:

Tivoli Storage Manager for Storage Area Networks support

Storage agent and client compatibility with Tivoli Storage Manager servers

Tivoli Storage Manager support

Configuring the devices on the server
To set up LAN-free communications on the Tivoli Storage Manager server, you
must set up server-to-server communication and configure the devices on the
server.

Before you begin

Before you begin the procedure, ensure that you have the information that is
recorded in the configuration-information worksheets.

About this task

Complete these tasks to set up server-to-server communication and configure
devices on the server:
1. “Setting up server-to-server communication” on page 39
2. “Configuring SAN drives” on page 41
3. “Setting the LAN-free destination” on page 41
4. “Confirming client node registration and configuration” on page 42
Related reference:
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“Configuration work sheets for storage agent configuration” on page 12

Setting up server-to-server communication
Server-to-server communication is required for Tivoli Storage Manager servers and
storage agents to share library devices on a SAN.

Procedure

To set up server-to-server communication, issue the following commands on the
Tivoli Storage Manager server. Replace the example values with values from the
configuration-information worksheet.
set servername tsmsrver
set serverpassword not4u
set serverhladdress tsmsrver.example.com
set serverlladdress 1502

Results

These commands establish the server's name, password, TCP/IP address, and port.

What to do next

Verify that the password is set for the server by issuing the QUERY STATUS
command from a Tivoli Storage Manager administrative command line. The value
of the Server Password Set field in the command output must be YES.

Configuring a storage agent and server to use SSL
You can set up a storage agent and the Tivoli Storage Manager server to use the
Secure Sockets Layer (SSL) communication method. SSL is set up independently on
both the storage agent and the Tivoli Storage Manager server.

Procedure

To set up the storage agent to use SSL communication with the Tivoli Storage
Manager server and client, complete the following steps:
1. On the storage agent, issue the DSMSTA SETSTORAGESERVER command to

initialize the storage agent and add communication information to the device
configuration file and the storage agent options file dsmsta.opt:

Hint: The following command is entered on one line, but is displayed here on
multiple lines to make it easier to read.
dsmsta setstorageserver myname=sta
mypa=sta_password
myhla=ip_address
servername=server_name
serverpa=server_password
hla=ip_address
lla=ssl_port
STAKEYDBPW=password
ssl=yes

Requirement:

v When you set the SSL=YES and STAKEYDBPW=password parameters, a key
database file is set up in the storage agent options file, dsmsta.opt. All
passwords are obfuscated in dsmsta.opt.
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v To enable SSL communication, ensure that the Tivoli Storage Manager LLA
parameter specifies the server SSLTCPADMIN port. If the SSLTCPADMIN is not
specified, use the SSLTCPPORT port instead. Set the SSL parameter to YES.

2. Import the Tivoli Storage Manager server certificate, cert256.arm, to the key
database file for the storage agent. Ensure that the required SSL certificates are
in the key database file that belongs to each storage agent that uses SSL
communication. To import the SSL certificate, switch to the storage agent
directory and issue the following command:
gskcapicmd_64 -cert -add -label server_example_name
-db cert.kdb -stashed -file cert256.arm -format ascii

3. Specify the SSLTCPPORT and the SSLTCPADMINPORT options in the dsmsta.opt
options file.

4. Create the key database certificate and default certificates by starting the
storage agent.

Tip: To provide the new password to the storage agent, you must change the
key database password and then issue the DSMSTA SETSTORAGESERVER
command.
a. Open a command window and change the password by issuing the

following command:
gsk8capicmd_64 -keydb -changepw -db cert.kdb -pw oldpw -newpw newpw

b. Rerun the DSMSTA SETSTORAGESERVER command and specify the
STAKEYDBPW=newpassword parameter.

5. On the Tivoli Storage Manager server, issue the following command:
define server sta
hla=ip_address
lla=ssl_port
serverpa=password
ssl=yes

6. Stop the storage agent.
7. Stop the Tivoli Storage Manager server.
8. Import the cert256.arm certificate from the storage agent to the key database

file for the Tivoli Storage Manager server. Ensure that the required SSL
certificates are in the key database file that belongs to each server that uses
SSL communication before you restart the server. To import the SSL certificate
from the storage agent, issue the following command:
gskcapicmd_64 -cert -add -label server_example_name
-db cert.kdb -stashed -file cert256.arm -format ascii

9. Stop and restart the Tivoli Storage Manager server.
10. Restart the storage agent.

Results

When the Tivoli Storage Manager server and storage agent initiate communication,
SSL certificate information is displayed to indicate that SSL is in use.

40 IBM Tivoli Storage Manager for SAN for Linux: Storage Agent User's Guide



Configuring SAN drives
Drive-configuration requirements vary depending on whether you are using tape
devices or disk devices.

Configuring tape drives
You can connect tape drives to the storage agent to allow for LAN-free backups
and restores of data.

Before you begin

Before you configure the tape drives, you must have the library manager and a
library definition defined. Optionally, you can have library clients that are defined.

About this task
v To configure tape drives to the storage agent, complete the following steps on

the library manager:
1. Update the shared ACSLS, SCSI, VTL, or 3494 library by setting the SHARED

parameter to YES.
2. Define paths from the storage agent server definition to each of the drives by

using the DEFINE PATH command.

Configuring disk drives
A FILE (sequential-access disk) device class is required for disk drives.

Procedure

Configure disk drives by completing the following steps:
1. Configure server-to-server communication.
2. Define a device class of DEVTYPE=FILE and SHARED=YES. Tivoli Storage Manager

automatically defines a new FILE library and also defines drives corresponding
to the mount limit for the FILE device class. The FILE library name is the same
as the device class name. Each drive uses the library name with a numeric
suffix. If the mount limit is changed, the number of drives also changes.

What to do next

Each session gets exclusive access to a file volume. To optimize performance,
match the mount limit to the number of volumes.

Setting the LAN-free destination
The destination for data must be a LAN-free capable storage pool.

Procedure

Set a LAN-free destination by completing the following steps:
1. Define a copy group with a destination to the LAN-free capable storage pool

that you created when you configured the SAN drives. For example:
define copygroup sandirect sandirectpolicy sandirectdefmft
type=backup destination=storage_pool_name

Note: If you are using a hierarchical storage management (HSM) client that is
configured for LAN-free data movement, set the management class (not the
copy group) to a LAN-free capable storage pool.
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2. Activate the policy set. For example:
activate policyset sandirect sandirectpolicy

What to do next

For details about changing policy for clients that can use SAN drives, see the
Administrator's Guide. For details about commands, see the Administrator's Reference.

Remember: If you decide not to use the default management class for the SAN
drives, you must create a new management class. Clients that use SAN drives need
an include statement to bind their files to the new management class. For details
about the include-exclude list, see the Backup-Archive Clients Installation and User's
Guide.

Confirming client node registration and configuration
Client nodes must be registered and configured for LAN-free backups.

Procedure

Verify that node settings are correct by issuing the following command:
query node node_name format=detailed

What to do next

If node settings are not correct, issue the UPDATE NODE command to adjust the
settings. If the node was not registered and configured for LAN-free backups,
register the node with the REGISTER NODE command.

To improve performance of your LAN and SAN resources for LAN-free data
movement, you can control the path that data transfers take for each LAN-free
capable client. Use the REGISTER NODE and UPDATE NODE commands to specify
whether data read/write operations use the LAN path only, the LAN-free path
only, or either path.

If the node belongs to a multi-threaded client and there are drives available, the
MAXNUMMP parameter might restrict the number of drives that are available for the
storage agent to use on behalf of the client. Specify the MAXNUMMP parameter on the
REGISTER NODE or UPDATE NODE command.

For more information about commands, see the Administrator's Reference.

Defining paths from the storage agent to drives
Paths allow a client, by using a storage agent, access to the library drives that are
available to the Tivoli Storage Manager server. Path-definition requirements
depend on the type of device that you are using.

Before you begin

Before you begin defining paths to your SAN drives, consider the following
guidelines:
v If not already done, obtain the names of your tape or disk devices. If you are

configuring tape devices, review the device names. The name of a tape device as
known to the server will probably not match the name of the same tape device
as known to the storage agent.
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v You must define paths on the library manager for the storage agent to each
drive that the storage agent will access. In addition, you must define a path for
the library manager to each drive so that the storage agent can use the drive.

Related tasks:
“Obtaining device information” on page 18

Defining paths for tape devices
You must define paths on the Tivoli Storage Manager server by using the device
names as identified by the storage agent on each client system.

About this task

Procedure

Define paths by issuing the DEFINE PATH command on the Tivoli Storage Manager
server that is designated as the library manager. For example:
define path storagnt drive1 srctype=server desttype=drive
library=sanlib1 device=/dev/tsmscsi/mt1

What to do next

Be sure that the device names are what the storage agent identifies on each client
system. For the same tape device, the device name as known to the server will
probably not match the device name as known to the storage agent. Failures can
occur if incorrect device information is provided in the DEFINE PATH command. For
details about this command, see the Administrator's Reference.

Depending on the operating system of the Tivoli Storage Manager server, there
might not be a quick way to confirm which device names on the storage agent
correspond to device names on the Tivoli Storage Manager server without using a
trial-and-error method.

To confirm device names, work with one online drive at a time, and cycle through
the storage agent device names until you can run a successful backup. The server
cannot validate path information that is provided on the server for use by the
storage agent.

When you define paths on the server, you can specify AUTODETECT=YES to
automatically update the serial number for a drive or library in the database. The
updated serial number is the same serial number that the drive reports to Tivoli
Storage Manager. After you complete a backup to verify LAN-free configuration,

SAN
Tivoli Storage
Manager backup-
archive client Tivoli Storage

Manager server
TSMSRVER

Library manager DB2

Storage agent
STORAGNT

Tape library drive

device name:
/dev/tsmscsi/mt1

define path storagnt drive1 srctype=server
destype=drive library=sanlib1 device=/dev/tsmscsi/mt1

Figure 7. Device information
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you can issue the QUERY DRIVE command to determine the device name from the
storage agent.
Related tasks:
“Verifying the LAN-free configuration” on page 46

Defining paths for disk devices
You must define paths on the Tivoli Storage Manager server by using the disk
device names as seen by the storage agent on each client system.

Example

For example, suppose the directory d:\tsmdata\server1 is GPFS mounted on the
Tivoli Storage Manager server. On the storage agent, the directory is GPFS
mounted as /tsmdata/server1.

Issue the DEFINE PATH command to create the path for this scenario.

In the following example, disklib1 represents the destination file drive in the disk
library named disklib:
define path storagnt disklib1 srctype=server desttype=drive library=disklib
device=file directory="/tsmdata/server1/fs1,/tsmdata/server1/fs2"

Recommendation: Make each directory correspond to a file system on a separate
physical drive. The server cannot validate PATH information that is provided on
the server for use by the storage agent. Failures can occur if incorrect device
information is provided in the DEFINE PATH command.

If you specify multiple directories for the device class that is associated with the
FILE library, you must specify the same number of directories for each path to the
FILE library. To keep the device class and path synchronized, do not change or
move existing directories on the server that the storage agent is using. Adding
directories is permitted. Specifying a mismatched number of directories can cause a
runtime failure. For more information, see the Administrator's Guide.

For details about the DEFINE PATH command, see the Administrator's Reference.

DB2

SAN

Tivoli Storage
Manager backup-
archive client

Tivoli Storage
Manager server

SERVER1

Storage agent
STORAGNT

define path storagnt disklib1 srctype=server
desttype=drive library=disklib device=file
directory="/tsmdata/server1/fs1,/tsmdata/server1/fs2”

storage agent directory:
/tsmdata/server1

Figure 8. Device information
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Preventing tape label overwrites
Tivoli Storage Manager tape labels can be overwritten by an application that uses a
generic or native driver. If tape labels are overwritten, data can be lost.

Preventing tape label overwrites
Tivoli Storage Manager tape labels can be overwritten by an application that uses a
generic or native driver. If tape labels are overwritten, data can be lost.

About this task

The Tivoli Storage Manager Passthru device driver uses the Linux SCSI generic
device driver (sg) to control and operate tape devices that are attached on the
system. If the Linux generic SCSI tape device driver (st) is loaded to the kernel and
configures attached tape devices, conflicts about how a device is managed can
result. The reason for the conflicts is that the generic sg driver and the st driver
can both control the same device. To prevent tape label overwrites, complete one of
the following tasks:

If the st driver controls devices that are used by Tivoli Storage Manager, Tivoli
Storage Manager internal tape labels can be overwritten and data can be lost. If an
application uses the st driver to control devices and the non-rewind option is not
specified, tapes are automatically rewound following completion of an operation.
The auto-rewind operation relocates the tape header position to the beginning of
the tape. If the tape remains loaded in the drive, the next non-Tivoli Storage
Manager write operation overwrites the Tivoli Storage Manager tape label because
the label is at the beginning of the tape.

To prevent Tivoli Storage Manager labels from being overwritten, ensure that only
the Tivoli Storage Manager Passthru driver controls devices that are used by Tivoli
Storage Manager. Remove the st driver from the kernel. Alternatively, if the driver
is used by some applications on the system, delete the special files that correspond
to Tivoli Storage Manager devices. Deleting the special files ensures that the st
driver can no longer control them.

If you are using the IBMtape device driver to control devices on your system, you
might encounter the same issues with device driver control conflicts. Review your
IBMtape documentation to determine how to resolve this issue and prevent data
loss.

Procedure
v Remove the st driver.

If no other applications on the system use st devices, remove the st driver from
the kernel. Issue the following command to unload the st driver:
rmmod st

v Delete device special files that correspond to Tivoli Storage Manager devices.
If there are applications that require use of the st driver, delete the special files
that correspond to Tivoli Storage Manager devices. These special files are
generated by the st driver, so when they are eliminated, the st driver can no
longer control the corresponding Tivoli Storage Manager devices. Device special
file names for tape drives are displayed in the /dev/ directory. They have the
form /dev/[n]st[0-255][l][m][a].
List the st drive special file names and Tivoli Storage Manager device special file
names by using the ls command. Based on the output of the device sequences,
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you can find devices in the st devices list that matches devices in the Tivoli
Storage Manager devices list. You can them use the rm command to delete st
devices.
Issue the following commands to list the st and Tivoli Storage Manager devices:
ls -l /dev/*st*
ls -l /dev/tsmscsi/mt*

Delete the st devices with the rm command:
rm /dev/*st*

Verifying the LAN-free configuration
To ensure LAN-free data movement, you must verify that the hardware and
software components are configured correctly.

Before you begin

Verify that the server is online and running before you verify the LAN-free
configuration.

Procedure

Verify LAN-free configuration by completing the following steps:
1. Start the storage agent:

Change to the storage agent directory and issue the DSMSTA command.
When the storage agent starts, it contacts all available shared libraries,
including those libraries that do not have a defined path. As a result, a delay
might occur during startup processing. The storage agent also determines if the
Tivoli Storage Manager server is a library client or library manager. If the
server is a library client, the storage agent attempts to define itself to the library
manager if it is not known to the library manager. When the storage agent
communicates with the Tivoli Storage Manager server, Secure Sockets Layer
(SSL) information is displayed to indicate when SSL is in use.

2. Specify the DISPLAYLFINFO=YES option in your server options file. Doing so
allows the accounting records and summary table entries to report the storage
agent name.

Important: This option might cause existing outboard automation that relies
on the summary table or accounting records to fail to recognize some activities
for a selected client. Before you set the DISPLAYLFINFO option, consider how this
outcome can affect your environment.

3. Determine which destinations for a node are capable of LAN-free data
movement by issuing the VALIDATE LANFREE command. The output of this
command also provides explanations about destinations that are not LAN-free
capable. Use this information to correct your configuration before you proceed
to the next step.

4. Run a backup operation from the client.
5. If you receive a message that indicates that the backup failed, verify the

following items:
v The Tivoli Storage Manager server is running. If the Tivoli Storage Manager

server is not running, the storage agent will not start.
v The client, storage agent, and server are communicating with each other as

expected.
v The paths to the drives are correctly defined.
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v All drives in a library are defined paths from the server.

If you try the backup operation again after the first failure, the client attempts
to use the LAN connection for data movement. To force LAN-free data
movement, stop and restart the client.

Determining whether the data movement was LAN-free
Messages and backup reports can indicate whether LAN-free operations are
successful. You can also use the QUERY SESSION and QUERY ACTLOG commands to
verify LAN-free operations.

Procedure

Use one or more of the following methods to determine whether the data
movement was LAN-free:
v When data transfers on a LAN-free path, the following message is displayed to

inform you that the client is starting a session with the storage agent and that
LAN-free data movement occurred:
ANR0415I Session session_number proxied by storage_agent_name for node
your_node_name

v View the backup report that is issued when backup processing completes. If
LAN-free data movement occurred, the number of LAN-free bytes that are
transferred is greater than zero.

v Verify that the sessions are established and that LAN-free data movement is
occurring:
1. Using a Tivoli Storage Manager administrative command-line client, log in to

the storage agent and the Tivoli Storage Manager server.
2. Issue the QUERY SESSION command for the node that is running the LAN-free

backup. In the command output, look for information about bytes sent and
bytes received. If LAN-free data movement is occurring:
– Querying a session on the storage agent shows bytes received for the node

that is increasing to the total amount of data that is being backed up.
– Querying a session on the Tivoli Storage Manager server shows a few

bytes of metadata that is received for the same node.

If the node's session has these characteristics, the data movement is
LAN-free.

Tip: During a failover when the storage agent is sending data directly to the
server by proxy because it cannot store the data directly, the session statistics on
the server show a much higher byte count.

v Issue either of the following QUERY ACTLOG commands on the server to which the
client is connected:
– query actlog search=storage_agent_name msgno=8337

– query actlog search=storage_agent_name

If the query locates entries in the activity log that relate to the storage agent, the
client is using LAN-free data transfer.

Related information:
Connecting to a Tivoli Storage Manager storage agent by using an administrative
command-line client
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Chapter 4. Installing and configuring external-library
environments

An external library is controlled by software, for example a drive such as IBM
Enterprise Removable Media Manager or Gresham Enterprise DistribuTape. To use
the drives in the external library, the Tivoli Storage Manager server and the storage
agent act independently as a client application to the software.

Before you begin

Before you install and configure the external-library environments, complete the
following steps:
v Ensure that you understand the overall installation and configuration process

because it takes place on different systems at different times.
v Ensure that you have the information that is recorded in the

configuration-information worksheets.
v Obtain an external library manager that can use the external library interface, for

example, IBM Enterprise Removable Media Manager. For details about
interfaces, see the Administrator's Guide.

v You can use the Gresham's Enterprise DistribuTape to manage the environment
instead of ACSLS.

About this task

The major installation and configuration steps are in the following list:
1. “Establishing network connections”
2. “Installing and configuring software on client systems” on page 50
3. “Configuring the devices on the server” on page 60
4. “Verifying the LAN-free configuration” on page 65
5. “Determining whether the data movement was LAN-free” on page 66
Related concepts:
“External libraries” on page 22
Related reference:
“Configuration work sheets for storage agent configuration” on page 12

Establishing network connections
Tivoli Storage Manager for storage area networks requires specific levels and
models of hardware and software. You must ensure that your system meets these
requirements.

Procedure

Establish network connections by attaching the server system and the client
systems to the LAN and to the SAN along with appropriate storage devices. For
details levels and models of hardware and software, see http://www.ibm.com/
software/sysmgmt/products/support/IBMTivoliStorageManager.html.
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Installing and configuring software on client systems
You install storage agents and backup-archive or Tivoli Storage Manager Data
Protection clients on client systems. If you install a Data Protection application
client, you must also install the Tivoli Storage Manager API.

About this task

Install and configure the software by completing the following tasks:
1. “Installing and configuring the client”
2. Only Data Protection application clients:“Installing and configuring the API” on

page 53
3. “Installing the storage agent” on page 54
4. “Configuring the storage agent” on page 59
Related concepts:
“Communications between the client, storage agent, and Tivoli Storage Manager
server” on page 8
Related tasks:
“Verifying and updating client node information” on page 52
“Verifying and updating client node information” on page 30
“Verifying and updating client node information” on page 78

Installing and configuring the client
The client can be a Tivoli Storage Manager backup-archive client or a Tivoli
Storage Manager Data Protection application client.

Before you begin

Before you install and configure the client, you must complete the following steps:
v Verify that the client system meets the prerequisites for client software. To

ensure software compatibility, check the website for Tivoli Storage Manager
storage agent and backup-archive client compatibility. You can download the
latest software levels from http://www.ibm.com/support/entry/portal/
Overview/Software/Tivoli/Tivoli_Storage_Manager.
For details about installing a backup-archive client, see the Backup-Archive Clients
Installation and User's Guide. For details about installing a Data Protection
application client, see the Data Protection Installation and Users Guides.

v Ensure that you completed the configuration worksheets.
v Ensure that client nodes are registered and configured on the server. To register

client nodes, use the REGISTER NODE or UPDATE NODE command.

Requirement: If multiple clients are using LAN-free data movement, install or
upgrade the client software on each client system.

Procedure

Install and configure the client by completing the following steps:
1. Install or upgrade the backup-archive client software or Data Protection

application-client software.
2. Using the information that you collected in the configuration worksheets,

modify the following file:
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v dsm.sys client system-options file

Tip: The file can be in one of several places, such as the installation directory,
or in a location pointed to by an environment variable.
Specify the communication method to be used between the client and server.

Table 11. Communications methods

To use this communication
method Install this software

To connect to these Tivoli
Storage Manager servers

TCP/IP TCP/IP (standard with
supported operating
systems)

AIX, HP-UX, Linux x86_64,
Linux on System z, Linux on
Power Systems, Solaris,
Windows Server

Shared memory TCP/IP (standard with
platforms)

Linux x86_64, Linux on
System z, Linux on Power
Systems

For example:
commmethod tcpip
tcpserveraddress server_c.example.com
tcpport 1502

The preceding example uses a TCPPORT of 1502. However, the default TCPPORT is
1500.
Do not close the file.

Remember: The backup-archive client SERVERNAME option is not related to the
storage agent SERVERNAME option. For details, see the Backup-Archive Clients
Installation and User's Guide.

3. Add the following options to the same stanza in the same file that you edited
in step 2 on page 50. These options specify that the client uses SAN-attached
devices, when the path is available, during backup, restore, archive, and
retrieve processing.
enablelanfree yes
lanfreecommmethod tcpip
lanfreetcpserveraddress agent.example.com
lanfreetcpport 1500

or
enablelanfree yes
lanfreecommmethod SharedMem
lanfreeshmport 1510

What to do next

If you installed a Data Protection application client, you must install and configure
the Tivoli Storage Manager client API.
Related concepts:
“Communications between the client, storage agent, and Tivoli Storage Manager
server” on page 8
Related tasks:
“Verifying and updating client node information” on page 52
“Verifying and updating client node information” on page 30
“Verifying and updating client node information” on page 78
Related reference:
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“Client-system and server-system configuration work sheets” on page 12
Related information:

Tivoli Storage Manager for Storage Area Networks support

Storage agent and client compatibility with Tivoli Storage Manager servers

Tivoli Storage Manager support

Verifying and updating client node information
When you configure LAN-free data movement, you must register client nodes and
provide policy information about client nodes. You can also restrict when a client
node uses a LAN-free path.

Procedure

Verify client node information by completing the following steps:
1. Identify the client node or nodes that use the storage agent. In a typical

environment, a storage agent is used only by the client node that is on the
same system as the storage agent. However, you can configure two or more
client nodes to use the same storage agent.

2. Verify that the nodes are registered. If they are not registered, you must register
them. For details, see the Administrator's Guide.

3. Verify the policy information for the nodes. The copy group for backup and
archive must point to a storage pool that has a LAN-free path for a particular
storage agent. You define drive LAN-free paths and make them available for
the storage pool. To view the destinations that are capable of LAN-free data
movement, you can issue the VALIDATE LANFREE command on the server. For
details about this command, see the Administrator's Reference.

4. After you verify the registration and policy information for the nodes, you can
place restrictions on when a node can use the LAN-free path. The node
attributes DATAWRITEPATH and DATAREADPATH determine the restriction that is
placed on the node:
v To use only the LAN-free path on backup and archive operations, specify

DATAWRITEPATH.

Important: Backup and archive operations can fail if the LAN-free path is
unavailable.

v To use the LAN path on restore and retrieve operations, specify
DATAREADPATH.

For more information about commands and their attributes, see the
Administrator's Reference.

Related tasks:
“Configuring multiple clients to use the same storage agent” on page 97
“Using LAN and LAN-free paths in the same backup operation” on page 97
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Installing and configuring the API
If you are using a Tivoli Storage Manager Data Protection application client, you
must install and configure the Tivoli Storage Manager API.

Before you begin

Before you install and configure the API, verify that the client system meets the
prerequisites for the application programming interface (API) software. You can
download the latest software levels from the Tivoli Storage Manager product
support website.

For details about installing the API software, see the Backup-Archive Clients
Installation and User's Guide.

Requirement: If multiple Data Protection application clients are using LAN-free
data movement, configure the API on each client system.

Procedure
1. Install the Tivoli Storage Manager client API.
2. Specify the environment variables. The Tivoli Storage Manager API uses unique

environment variables to locate files.
v DSMI_CONFIG is the fully qualified name for the client user option file.
v DSMI_DIR points to the path that contains dsm.sys, dsmtca, and the

subdirectory en_US.
v en_US subdirectory must contain dsmclientV3.cat.
v DSMI_LOG points to the path for the dsierror.log file.

Tip: The quickest method to set the environment variables is to add these
variables to the user profile file.
The following examples show how to set up these environment variables in the
user profile:
export dsmi_config=/opt/tivoli/tsm/client/api/bin/dsm.opt
export dsmi_dir=/opt/tivoli/tsm/client/api/bin
export dsmi_log=/home/user_a/logdir

3. Edit an existing stanza or create a stanza in the dsm.sys file to specify the
communications options between the Tivoli Storage Manager API and server.
For example:
servername server_c
commmethod tcpip
enablelanfree yes
lanfreecommmethod tcpip
lanfreetcpserveraddress test.example.com
lanfreetcpport 1500
tcpport 1502
tcpserveraddress server_c.example.com

The example uses a TCPPORT of 1502. However, the default TCPPORT is 1500.
If a dsm.sys file does not exist in the directory that is specified by DSMI_DIR,
create a symbolic link to the dsm.sys file in the Tivoli Storage Manager client
installation directory. For example:
ln -s /opt/tivoli/tsm/client/ba/bin/dsm.sys

/opt/tivoli/tsm/client/api/bin/dsm.sys

Related reference:
“Client-system and server-system configuration work sheets” on page 12
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Related information:

Tivoli Storage Manager for Storage Area Networks support

Storage agent and client compatibility with Tivoli Storage Manager servers

Tivoli Storage Manager support

Installing the storage agent
The storage agent can be found in the Tivoli Storage Manager installation package.
You can obtain the installation package from the product DVD or from an IBM
download site.

Before you begin

If you plan to download the files, set the system user limit for maximum file size
to unlimited to ensure that the files can be downloaded correctly.
1. To query the maximum file size value, issue the following command:

ulimit -Hf

2. If the system user limit for maximum file size is not set to unlimited, change it
to unlimited by following the instructions in the documentation for your
operating system.

About this task

If you obtain the package from the product DVD, ensure that the installation files
are visible on the DVD drive.

If you obtain the package from an IBM download site, you must extract the
installation files.

Procedure
1. Download the appropriate package file from one of the following websites, or

you can access the files from the product DVD:
v For a first time installation or a new release go to Passport Advantage at:

http://www.ibm.com/software/lotus/passportadvantage/. Passport
Advantage is the only site that you can download a licensed package file
from.

v For the latest information, updates, and maintenance fixes, go to the Tivoli
Storage Manager support site: http://www.ibm.com/support/entry/portal/
Overview/Software/Tivoli/Tivoli_Storage_Manager.

2. If you download the package from one of the download sites, complete the
following steps:
a. Verify that you have enough space to store the installation files when they

are extracted from the product package.
b. Download the package file to the directory of your choice. The path must

contain no more than 128 characters. Be sure to extract the installation files
to an empty directory. Do not extract to a directory that contains previously
extracted files, or any other files.
Also, ensure that you have executable permission for the package file.

c. If necessary, change the file permissions by issuing the following command:
chmod a+x package_name.bin

d. Issue the following command to extract the installation files:
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./package_name.bin

where package_name is like the following example:
7.1.0.000-TIV-TSMSRV-LinuxX64.bin
7.1.0.000-TIV-TSMSRV-LinuxS390X.bin

3. Select one of the following methods of installing the storage agent from the
Tivoli Storage Manager installation package:
v “Installing the storage agent by using the installation wizard”
v “Installing the storage agent by using console mode” on page 56
v “Installing the storage agent in silent mode” on page 57

Related reference:
“DSMSTA SETSTORAGESERVER command” on page 107

Installing the storage agent by using the installation wizard
You can install or update the storage agent by using the IBM Installation Manager
graphical wizard.

Before you begin

Ensure that you review the following important information about installing:
v Verify that the operating system is set to the language that you require. By

default, the language of the operating system is the language of the installation
wizard.

On test servers only: Use the following command to bypass prerequisite checks
such as the operating system and the required memory. Do not issue this
command on a production server.
./install.sh -g -vmargs "-DBYPASS_TSM_REQ_CHECKS=true"

Procedure

Choose whether to install from a downloaded package file, or from the DVD, and
complete the following steps to begin the installation:

Option Description

Installing from a downloaded package file: 1. Change to the directory where you
downloaded the package file.

2. Start the graphical interface installation
wizard by issuing the following
command:

./install.sh

Installing from DVD media: 1. Insert the DVD into the DVD drive.
Tip: Ensure that the installation files are
visible on the DVD drive.

2. Start the graphical interface installation
wizard by issuing the following
command:

./install.sh
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What to do next
v If errors occur during the installation process, these errors are recorded in log

files that are stored in the IBM Installation Manager logs directory.
You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

Related concepts:
“Software requirements” on page 7
Related information:

Tivoli Storage Manager for Storage Area Networks support

Passport Advantage download document

Installing the storage agent by using console mode
You can install or update the storage agent by using the command line in console
mode.

Before you begin

Ensure that you review the following important information about installing:
v Verify that the operating system is set to the language that you require. By

default, the language of the operating system is the language of the installation
wizard.

On test servers only: Use the following command to bypass prerequisite checks
such as the operating system and the required memory. Do not issue this
command on a production server.
./install.sh -c -vmargs "-DBYPASS_TSM_REQ_CHECKS=true"

Procedure

Choose whether to install from a downloaded package file, or from the DVD, and
complete the following steps to begin the installation:

Option Description

Installing from a downloaded package file: 1. Change to the directory where you
downloaded the package file.

2. Start the installation wizard in console
mode, by issuing the following
command:

./install.sh -c

You can generate a response file as part
of a console mode installation. Complete
the console mode installation options,
and in the Summary panel, specify G to
generate the responses.
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Option Description

Installing from DVD media: 1. Insert the DVD into the DVD drive.
Tip: Ensure that the installation files are
visible on the DVD drive.

2. Start the installation wizard in console
mode, by issuing the following
command:

./install.sh -c

You can generate a response file as part
of a console mode installation. Complete
the console mode installation options,
and in the Summary panel, specify G to
generate the responses.

What to do next
v If errors occur during the installation process, these errors are recorded in log

files that are stored in the IBM Installation Manager logs directory.
You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

Related concepts:
“Software requirements” on page 7
Related information:

Tivoli Storage Manager for Storage Area Networks support

Passport Advantage download document

Installing the storage agent in silent mode
You can install or update the storage agent in silent mode without any user
interaction.

Before you begin

A silent installation can use response files for data input. The following sample
response files are provided for installing, updating, and uninstalling Tivoli Storage
Manager:
v install_response_sample.xml

v update_response_sample.xml

v uninstall_response_sample.xml

If you want to use one of the sample response files, they can be found after you
extract the package files, in the input subdirectory. You can use these sample files
as they are or you can customize them to suit your needs. It is optimal to use the
sample response files. These sample files contain instructions and default values to
help you avoid any unnecessary warnings.

On test servers only: Use the following command to bypass prerequisite checks
such as the operating system and the required memory. Do not issue this
command on a production server.

./install.sh -s -acceptLicense -vmargs "-DBYPASS_TSM_REQ_CHECKS=true"
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Procedure
1. Create a response file, or use one of the sample response files such as

install_response_sample.xml or update_response_sample.xml.
2. To start the silent installation, issue one of the following commands from the

directory where the installation package file is extracted:

Option Description

Installing from a
downloaded package file or
DVD media:

To start the installation by accepting the default values,
issue the following command:

./install.sh -s -acceptLicense

To start the installation with a custom response file, issue
the following command, where response_file represents the
response file path, including the file name:

./install.sh -s -input response_file -acceptLicense

What to do next
v If errors occur during the installation process, these errors are recorded in log

files that are stored in the IBM Installation Manager logs directory.
You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

Related concepts:
“Software requirements” on page 7
Related information:

Tivoli Storage Manager for Storage Area Networks support

Passport Advantage download document

Defining and configuring the storage agent
You must define and configure the storage agent to communicate with the
backup-archive client and the Tivoli Storage Manager server.

Defining storage agents to the Tivoli Storage Manager server
For each client that uses LAN-free data transfer, you must define a storage agent to
the server.

Before you begin

Use the same name and password that you specified for the storage agent when
you installed it on the client system.

Procedure

Define the storage agent by issuing the DEFINE SERVER command from the Tivoli
Storage Manager server that will manage the client data. For example:
define server storagnt serverpassword=fun4me

hladdress=agent.tucson.ibm.com lladdress=1500 validateprotocol=all

The VALIDATEPROTOCOL parameter in the example is optional. This parameter
specifies whether a cyclic redundancy check is run to validate data on all metadata
that is transferred between the storage agent and the Tivoli Storage Manager
server.
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For details about data validation, see the Administrator's Guide. For details about
the DEFINE SERVER command, see the Administrator's Reference.

What to do next

You must also define the storage agent to the library manager. The storage agent
must be able to contact the library manager directly when its makes mount
requests. If the storage agent is only defined to the library client, it attempts to use
information from the client to define itself to the library manager. If the storage
agent is unable to define itself to the library manager, then you must define the
storage agent manually by using the DEFINE SERVER command that is issued from
the library manager. For example:
define server storagnt serverpassword=fun4me

hladdress=agent.tucson.ibm.com lladdress=1500 ssl=yes

In the preceding example, the SSL parameter specifies that SSL communication is
used. If you specify SSL as the communication method, you must import SSL
certificates from the server to the storage agent, and from the storage agent to the
server. Import SSL certificates before you start the storage agent or the server.

When the storage agent is defined to the server, you can complete the steps in
“Configuring the storage agent.”

Configuring the storage agent
After the installation is completed, to ensure communication with the
backup-archive client and the Tivoli Storage Manager server, you must configure
the storage agent.

Before you begin
v Ensure that you complete the steps in “Defining storage agents to the Tivoli

Storage Manager server” on page 58.
v Use the information that you collected in the configuration worksheets.

Procedure

Configure the storage agent by completing the following steps:
1. Point the server to the storage agent by issuing the DEFINE SERVER command on

the Tivoli Storage Manager server.
2. Ensure that the DEVCONFIG option is specified in the storage agent options file

dsmsta.opt.
For example, for a device configuration file named devconfig.out, edit the
dsmsta.opt file by typing the following line:
DEVCONFIG devconfig.out

The device configuration file is in the following directory:
/opt/tivoli/tsm/StorageAgent/bin

3. Initialize the storage agent and add communication information by issuing the
DSMSTA SETSTORAGESERVER command. For example:
dsmsta setstorageserver myname=storagnt mypassword=fun4me
myhladdress=agent.example.com
servername=tsmsrver serverpassword=not4u
hladdress=tsmsrver.example.com lladdress=1502

Requirements:
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v The SERVERNAME option in the dsm.sys file, which is the client system options
file, must match the SERVERNAME option in the dsm.opt file, which is the client
user-options file. However, the option is unrelated to and does not need to
match the SERVERNAME option that is defined for the storage agent in the
storage-agent options file, dsmsta.opt.

v The HLADDRESS option must match the TCPSERVERADDRESS option that is in the
dsm.sys file on the Tivoli Storage Manager client. When you configure the
storage agent by using the DSMSTA SETSTORAGESERVER command, use
addresses that correspond to the communications method that is used by the
backup-archive client. With the backup-archive client, you can use either IPv4
(COMMMETHOD TCPIP option) or IPv6 (COMMMETHOD V6TCPIP option), but not
both.

v To secure communication between the storage agent and the Tivoli Storage
Manager server, ensure that your data is protected by Secure Sockets Layer
(SSL).

The DSMSTA SETSTORAGESERVER command generates the following output in the
storage agent device configuration file:
set staname storagnt
set stapassword xxxxxxx
set stahladdress agent.example.com
define server tsmsrver serverpassword=xxxxxxxxxxx
hladdress=tsmsrver.example.com lladdress=1502

In the preceding example, the passwords are encrypted.
The command also generates the following line in the dsmsta.opt file:
SERVERNAME tsmsrver

Related reference:
“Client-system and server-system configuration work sheets” on page 12
“Storage agent options file” on page 102
“DSMSTA SETSTORAGESERVER command” on page 107
“The device configuration file for the storage agent” on page 101
Related information:

Tivoli Storage Manager for Storage Area Networks support

Storage agent and client compatibility with Tivoli Storage Manager servers

Tivoli Storage Manager support

Configuring the devices on the server
To set up LAN-free communications on the Tivoli Storage Manager server, you
must set up server-to-server communication and configure the paths to the library.

Before you begin

Before configure the devices on the server, ensure that you have the information
that is recorded in the configuration-information worksheets.

Procedure

Set up server-to-server communication and configure devices on the server by
completing the following tasks:
1. “Setting up server-to-server communication” on page 61
2. “Installing an external media manager” on page 63
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3. “Configuring a path to the library manager” on page 63
4. “Defining paths for ACSLS” on page 64
5. “Setting the LAN-free destination” on page 64
6. “Confirming client node registration and configuration” on page 65

Setting up server-to-server communication
Server-to-server communication is required for Tivoli Storage Manager servers and
storage agents to share library devices on a SAN.

Procedure

Set up server-to-server communication by issuing the following commands on the
Tivoli Storage Manager server. Replace the values in the example with values from
the configuration-information worksheet.
set servername tsmsrver
set serverpassword not4u
set serverhladdress tsmsrver.example.com
set serverlladdress 1502
set crossdefine on

Results

These commands establish the server name, password, TCP/IP address, and port.
They also allow other servers to define a connection on this server.

What to do next

Verify that the password is set for the server by issuing the QUERY STATUS
command from a Tivoli Storage Manager administrative command line. The value
of the Server Password Set field in the command output must be YES.

For details about server-to-server communication, see the Administrator's Guide.

Configuring a storage agent and server to use SSL
You can set up a storage agent and the Tivoli Storage Manager server to use the
Secure Sockets Layer (SSL) communication method. SSL is set up independently on
both the storage agent and the Tivoli Storage Manager server.

Procedure

To set up the storage agent to use SSL communication with the Tivoli Storage
Manager server and client, complete the following steps:
1. On the storage agent, issue the DSMSTA SETSTORAGESERVER command to

initialize the storage agent and add communication information to the device
configuration file and the storage agent options file dsmsta.opt:

Hint: The following command is entered on one line, but is displayed here on
multiple lines to make it easier to read.
dsmsta setstorageserver myname=sta
mypa=sta_password
myhla=ip_address
servername=server_name
serverpa=server_password
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hla=ip_address
lla=ssl_port
STAKEYDBPW=password
ssl=yes

Requirement:

v When you set the SSL=YES and STAKEYDBPW=password parameters, a key
database file is set up in the storage agent options file, dsmsta.opt. All
passwords are obfuscated in dsmsta.opt.

v To enable SSL communication, ensure that the Tivoli Storage Manager LLA
parameter specifies the server SSLTCPADMIN port. If the SSLTCPADMIN is not
specified, use the SSLTCPPORT port instead. Set the SSL parameter to YES.

2. Import the Tivoli Storage Manager server certificate, cert256.arm, to the key
database file for the storage agent. Ensure that the required SSL certificates are
in the key database file that belongs to each storage agent that uses SSL
communication. To import the SSL certificate, switch to the storage agent
directory and issue the following command:
gskcapicmd_64 -cert -add -label server_example_name
-db cert.kdb -stashed -file cert256.arm -format ascii

3. Specify the SSLTCPPORT and the SSLTCPADMINPORT options in the dsmsta.opt
options file.

4. Create the key database certificate and default certificates by starting the
storage agent.

Tip: To provide the new password to the storage agent, you must change the
key database password and then issue the DSMSTA SETSTORAGESERVER
command.
a. Open a command window and change the password by issuing the

following command:
gsk8capicmd_64 -keydb -changepw -db cert.kdb -pw oldpw -newpw newpw

b. Rerun the DSMSTA SETSTORAGESERVER command and specify the
STAKEYDBPW=newpassword parameter.

5. On the Tivoli Storage Manager server, issue the following command:
define server sta
hla=ip_address
lla=ssl_port
serverpa=password
ssl=yes

6. Stop the storage agent.
7. Stop the Tivoli Storage Manager server.
8. Import the cert256.arm certificate from the storage agent to the key database

file for the Tivoli Storage Manager server. Ensure that the required SSL
certificates are in the key database file that belongs to each server that uses
SSL communication before you restart the server. To import the SSL certificate
from the storage agent, issue the following command:
gskcapicmd_64 -cert -add -label server_example_name
-db cert.kdb -stashed -file cert256.arm -format ascii

9. Stop and restart the Tivoli Storage Manager server.
10. Restart the storage agent.

Results

When the Tivoli Storage Manager server and storage agent initiate communication,
SSL certificate information is displayed to indicate that SSL is in use.
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Installing an external media manager
If you are using an ACSLS-managed external library, install middleware (for
example, IBM Enterprise Removable Media Manager) that enables an external
library. For installation information, see the product's documentation.

Configuring a path to the library manager
Configure a path to the library manager.

About this task

The procedure for configuring a path to the library manager depends on whether
you are using a shared ACSLS library manager or an ACSLS-managed external
library.

Procedure
v If you are using a shared ACSLS library manager, configure a path to the library

manager by completing the following steps from the library manager:
1. Define a library type of ACSLS. For example:

define library libmgr1 libtype=ACSLS shared=YES

2. Define a path from the server to the library manager. For example:
define path tsmsrver libmgr1 srctype=server desttype=library

3. Define a device class with a device type of LTO. For example:
define devclass device_class_name library=libmgr1
devtype=lto servername=tsmsrvr

4. Define the storage pool. For example:
define stgpool pool_name device_class_name pooltype=primary

v If you are using an ACSLS-managed external library, configure a path to the
external library manager.
1. Define a library type of EXTERNAL. For example:

define library stk-lib libtype=external

If a library name remains constant but the library type changes from
EXTERNAL to shared ACSLS, stop and restart the storage agent to register
this change.

2. Define a path from the server to the external media manager. For example:
define path tsmsrver stk-lib srctype=server desttype=library
externalmanager=path_name

In the example, the path that is provided for the external manager depends
on the operating system on which Tivoli Storage Manager server runs.

3. Define a device class with a device type of ECARTRIDGE. For example:
define devclass device_class_name library=library_name
devtype=ecartridge format=drive

4. Define the storage pool. For example:
define stgpool pool_name device_class_name pooltype=primary
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Defining paths for ACSLS
If you are using a shared ACSLS library manager, you must define a path from the
storage agent to the library manager. If you are using an ACSLS-managed external
library, you must define a path from the storage agent to the external manager.

Procedure
v To define a path for a shared ACSLS library manager, use the DEFINE PATH

command. For example:
define path storagnt libmgr1 srctype=server desttype=library

v To define a path for an ACSLS-managed external library, use the DEFINE PATH
command and define a path to the external media manager. For example:
define path storagnt stk-lib srctype=server desttype=library

externalmediamanager=path_name

What to do next

For details about the DEFINE PATH command, see the Administrator's Reference.

Setting the LAN-free destination
The destination for data must be a LAN-free capable storage pool.

About this task

Set a LAN-free destination by completing the following steps:

Procedure
1. Define a copy group with a destination to the LAN-free capable storage pool.

You created the storage pool as part of the procedure of configuring a path to
the library manager. For example:
define copygroup sandirect sandirectpolicy sandirectdefmft

type=backup destination=storage_pool_name

2. Activate the policy set. For example:
activate policyset sandirect sandirectpolicy

What to do next

For details about changing policy for clients that can use SAN drives, see the
Administrator's Guide. For details about the commands, see the Administrator's
Reference.

Remember:

v If you decide not to use the default management class for the SAN drives, create
a new management class. Clients that use the SAN drives need an include
statement to bind their files to this new management class.
For details about the include-exclude list, see the Backup-Archive Clients
Installation and User's Guide.

v With a hierarchical storage management (HSM) client that is configured for
LAN-free data movement, the management class (not the copy group) is set to a
LAN-free capable storage pool.

Related tasks:
“Configuring a path to the library manager” on page 63
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Confirming client node registration and configuration
Client nodes must be registered and configured for LAN-free backups.

Procedure

Verify that node settings are correct by issuing the following command:
query node node_name format=detailed

What to do next

If node settings are not correct, issue the UPDATE NODE command to adjust settings
for the node. If the node is not registered and configured for LAN-free backups,
register the node with the REGISTER NODE command.

To help tune the use of your LAN and SAN resources for LAN-free data
movement, you can control the path that data transfers take for clients that have
LAN-free data movement capability. For each client, you can select whether data
read/write operations use the LAN path, the LAN-free path, or either path. You
can specify these settings with the REGISTER NODE and UPDATE NODE commands.

If the node belongs to a multi-threaded client and there are drives available, the
MAXNUMMP parameter might restrict the number of drives that are available for the
storage agent to use on behalf of the client. Specify the MAXNUMMP parameter on the
REGISTER NODE or UPDATE NODE command.

For details about commands, see the Administrator's Reference.

Verifying the LAN-free configuration
To ensure LAN-free data movement, you must verify that the hardware and
software components are configured correctly.

Procedure

Verify the LAN-free configuration by completing the following steps:
1. Start the storage agent by changing to the storage agent directory and issuing

the DSMSTA command.

Tip: When the storage agent starts, it contacts all available shared libraries,
including those libraries that do not have a defined path. As a result, a delay
might occur during startup processing. The storage agent also determines if the
Tivoli Storage Manager server is a library client or library manager. If the
server is a library client, the storage agent attempts to define itself to the library
manager if it is not known to the library manager. When the storage agent
communicates with the Tivoli Storage Manager server, Secure Sockets Layer
(SSL) information is displayed in the activity log to indicate whether SSL is in
use.

2. Run a backup operation from the client.
3. Log on to the Tivoli Storage Manager server and storage agent by using a

Tivoli Storage Manager administrative command-line client.
4. Verify that the backup is LAN-free and the sessions are established by issuing

the QUERY SESSION command. In the command output, look for information
about bytes sent and bytes received. If LAN-free data movement is occurring:
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v Querying a session on the storage agent shows bytes received for the node
that increases to the total amount of data that is backed up.

v Querying a session on the Tivoli Storage Manager server shows a few bytes
(metadata) received for the same node.

If the node's session has these characteristics, and you receive a message that
states that the backup was successful, you configured your system correctly.
There are several ways to use the QUERY SESSION command. If the storage agent
is running in the foreground, it is started in the command-line window. The
window is the storage agent console, and you can issue the command on the
console. Alternatively, you can use a command-line client to connect to the
storage agent on the administration port of the storage agent. Use the same
administrator ID and password for this command that you use on the server.

5. If you receive a message that states that the backup failed, ensure that the
following conditions exist:
v The Tivoli Storage Manager server is running. If the Tivoli Storage Manager

server is not running, the storage agent does not start.
v The client, storage agent, and server are communicating with each other as

expected.
v The mount and message is displayed on the storage agent console.

If you try the backup operation again after the first failure, the client attempts
to use the LAN connection for data movement. To force LAN-free data
movement, stop and restart the client.

Determining whether the data movement was LAN-free
Messages and backup reports can indicate whether LAN-free operations are
successful. You can also use the QUERY SESSION and QUERY ACTLOG commands to
verify LAN-free operations.

Procedure

Determine whether data movement is LAN-free by using one or both of the
following methods:
v Monitor the QUERY SESSION output against the node that is running the LAN-free

backup. Verify that the sessions are established:
1. Log in to the Tivoli Storage Manager server and storage agent by using a

Tivoli Storage Manager administrative command-line client.
2. Verify that the backup is LAN-free and the sessions are established by

issuing the QUERY SESSION command. In the command output, look for
information about bytes sent and bytes received. If LAN-free data movement
is occurring:
– Querying a session on the storage agent shows bytes received for the node

that increases to the total amount of data that is backed up.
– Querying a session on the Tivoli Storage Manager server shows a few

bytes (metadata) received for the same node.

If the node's session shows these characteristics, the data movement is LAN-free.

Remember: During a failover where the storage agent is sending data directly
to the server by proxy because it cannot store the data directly, the QUERY
SESSION statistics on the server show a much higher byte count.
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v Issue either of the following QUERY ACTLOG commands on the server to which the
client is connected:
query actlog search=storage_agent_name msgno=8337
query actlog search=storage_agent_name

If the query locates entries in the activity log that relate to the storage agent, the
client is using LAN-free data transfer.

Related information:
Connecting to a Tivoli Storage Manager storage agent by using an administrative
command-line client
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Chapter 5. Installing and configuring the storage agent for
data movement to a z/OS media server

Tivoli Storage Manager for z/OS Media provides access to z/OS media library
resources. The storage agent is configured to access z/OS resources that are
controlled by the z/OS media server.

Before you begin

Before you begin this procedure:
v Ensure that you understand the overall installation and configuration process

because it takes place on different systems at different times.
v Ensure that you completed the “Client-system and server-system configuration

worksheets for z/OS Media” on page 16.
v Install and configure Tivoli Storage Manager by using the instructions in the

Installation Guide.
v Configure the Tivoli Storage Manager server to use z/OS media server storage

by using the instructions in the Administrator's Guide.
v Install and configure Tivoli Storage Manager for z/OS Media on your operating

system by using the instructions in the Tivoli Storage Manager for z/OS Media
Installation and Configuration Guide.

About this task

The main installation and configuration steps are:
1. “Establishing network connections” on page 72
2. “Installing and configuring software on client systems” on page 76
3. “Setting up storage agent data transfer on the Tivoli Storage Manager server”

on page 87
4. “Configuring the storage agent” on page 85
5. “Verifying the storage agent configuration” on page 89
Related concepts:
“External libraries” on page 22
Related reference:
“Configuration work sheets for storage agent configuration” on page 12
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Tivoli Storage Manager for z/OS Media overview
Tivoli Storage Manager for z/OS Media enables client systems to write data to, or
read data from, storage devices that are attached to a z/OS system.

Data movement between the storage agent and the z/OS media server is not a
typical LAN-free data transfer. The storage agent moves data to the z/OS media
server in the following way:
1. The storage agent installed on a client system communicates with the Tivoli

Storage Manager server, through a LAN, to obtain and store database
information and to coordinate device and volume selection. The storage agent
is configured to access the z/OS resources that are controlled by the z/OS
media server.

2. The z/OS media server mounts the FILE or tape volumes. The client (through a
storage agent) accesses volumes that are managed by the z/OS media server.

3. The storage agent sends client data to the z/OS media server to be written on
FILE or tape. The Tivoli Storage Manager server stores the metadata, such as
policy information and file name and size, that the client provided.

z/OS FILE volumes do not have to be formatted for storage agent data transfer
from Tivoli Storage Manager storage agents. The Tivoli Storage Manager server
formats the file volume when data is written to it.

The z/OS media server is a Tivoli Storage Manager library resource. A library type
of ZOSMEDIA represents FILE or tape storage volumes in a FICON® attached
library. Tivoli Storage Manager for z/OS Media maintains access to the storage
resources and handles mount requests from the Tivoli Storage Manager server. The
Tivoli Storage Manager server communicates with the storage agent to provide
volume, library, and authentication details to the storage agent.

LAN

FICON
storage media

Tivoli Storage
Manager
backup-

archive client

Storage
agent

Tivoli Storage
Manager server

z/OS
media
serverDB2

Figure 9. A z/OS media server environment
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The z/OS media server can be used for scratch and private FILE volume mount
requests for storing and retrieving new data.

Data flow from a Tivoli Storage Manager backup-archive client to the
z/OS media server

When you use z/OS media server storage for backup-archive client data, the Tivoli
Storage Manager server directs data flow over the LAN.

About this task

A typical backup operation to z/OS media server storage consists of the steps that
are outlined in Figure 10:

Procedure
1. The backup-archive client contacts the storage agent.
2. The storage agent contacts the Tivoli Storage Manager server for a volume

selection.
3. The storage agent sends a mount request to the z/OS media server.
4. The z/OS media server loads the FICON attached drive.
5. The storage agent notifies the Tivoli Storage Manager server and provides the

volume name (if it is a scratch volume).
6. The storage agent sends the data to the z/OS media server.
7. The Tivoli Storage Manager stores metadata from the storage agent.
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Figure 10. Data flow from the backup-archive client to z/OS media server storage
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Establishing network connections
You must establish network connections from the client, with the storage agent
installed, to the z/OS system where the Tivoli Storage Manager for z/OS Media is
installed.

For details, levels, and models of hardware and software, see http://
www.ibm.com/support/entry/portal/Overview/Software/Tivoli/
Tivoli_Storage_Manager.

The Tivoli Storage Manager server system, the z/OS media server system, and the
client systems along with appropriate storage devices are all attached to a LAN.
You must define the following paths to establish network connections:
v Storage agent to the z/OS media server
v Backup-archive client to the Tivoli Storage Manager server
v Tivoli Storage Manager server to the z/OS media server
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backup-
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Tivoli Storage
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DB2
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Figure 11. Network connection between a storage agent, a Tivoli Storage Manager server,
and a z/OS media server. Client data is transferred between the storage agent and the z/OS
media server.

72 IBM Tivoli Storage Manager for SAN for Linux: Storage Agent User's Guide

http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/Tivoli_Storage_Manager
http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/Tivoli_Storage_Manager
http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/Tivoli_Storage_Manager


You can use multiple network connections to establish a connection to a z/OS
media server. For example, if you use a high-bandwidth connection, you can use
multiple network connections to access a z/OS media server.

Client data is transferred between the storage agent and the z/OS media server
server through LAN 1. Metadata is transferred from the storage agent to the Tivoli
Storage Manager server, through LAN 2.

Establishing network connections in a Linux for System z
environment

You can establish network connections for data movement from a storage agent to
a z/OS media server on Linux for System z®.
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Figure 12. Network connection between a storage agent, a Tivoli Storage Manager server,
and a z/OS media server, using two LANs.
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Figure 13 displays a Tivoli Storage Manager for Linux on System z server that
connects to a z/OS media server by using HiperSockets™. Client data is transferred
between the storage agent and the z/OS media server using HiperSockets.
Metadata is transferred from the storage agent to the Tivoli Storage Manager
server, by using HiperSockets. It is possible that the connection from the Tivoli
Storage Manager server to the z/OS media server can be isolated from the network
connection of the client. Network addresses are specified in the server definition of
the z/OS media server.

Table 12. Sample commands for establishing network connections in a Linux for System z Environment

Purpose Sample command

Define the library resource. define library zosmedia libtype=zosmedia

Define the storage agent. define server sqlstgagent
serverpassword= sqlstgagentpw
hladdress=9.6.5.41
lladdress=1500
description="sql storage agent for z/os
media storage access"

Define the Linux for System z storage agent. define server zlinuxstgagent
serverpassword= zlinuxstgagentpw
hladdress=hipersockets
lladdress=1556
description="zlinux storage agent hipersockets
for z/os media storage access"

Build a definition representative of the HiperSockets link to the
z/OS media server.

define server zosmedservhiper
serverpassword=zosmedservpw
hladdress=hipersockets
lladdress=1555
description="hipersockets link
provides tsm server access to
z/os media storage"
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Figure 13. Data movement from a storage agent to a Linux for System z can communicate
with a z/OS media server using HiperSockets.
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Table 12. Sample commands for establishing network connections in a Linux for System z Environment (continued)

Purpose Sample command

Define a library path for the Tivoli Storage Manager server to
access z/OS media server by using HiperSockets.

define path server1 zosmedia
srctype=server
desttype=library
zosmediaserver=zosmedservhiper

This example uses server1 for the Tivoli Storage Manager server
name.

Build a definition representative of the external LAN link to the
z/OS media server.

define server zosmedservlan
serverpassword=zosmedservpw
hladdress=9.8.7.6
lladdress=1555
description="external lan provide
storage agent access to z/os
media storage"

Define a library path for the Tivoli Storage Manager storage
agent to access z/OS media server via external LAN.

define path sqlstgagent zosmedia
srctype=server
desttype=library
zosmediaserver=zosmedservlan

Define a library path for the Tivoli Storage Manager Linux for
System z storage agent to access z/OS media server by using
HiperSockets.

define path zlinuxstgagent zosmedia
srctype=server
desttype=library
zosmediaserver=zosmedservhiper

The SETSTORAGESERVER command can be used to configure the
storage agent for this example.

dsmsta setstorageserver myname=sqlstgagent
mypassword=sqlstgagentpw
myhladdress=9.6.5.41
servername=server1
serverpassword=server1
hladdress=9.6.5.4
lladdress=1577

Issue the SETSTORAGESERVER command to configure the storage
agent to use Secure Sockets Layer (SSL) for this example.

dsmsta setstorageserver myname=sqlstgagent
mypassword=sqlstgagentpw
stakeydbpw=stakeydbpassword
myhladdress=9.6.5.41
servername=server1
serverpassword=server1
hladdress=9.6.5.4
lladdress=1577

The SETSTORAGESERVER command can be used to configure the
Tivoli Storage Manager Linux for System z storage agent for this
example.

dsmsta setstorageserver myname=zlinuxstgagent
mypassword=zlinuxstgagentpw
myhladdress=hipersockets
servername=server1
serverpassword=server1
hladdress=hipersockets
lladdress=1577

Important: When a specific network address must connect the storage agent to the
z/OS media server, you must supply an additional server definition. In Table 12 on
page 74, the zosMedServLAN server is defined to expose the network address of
9.8.7.6 as a means of connecting to the z/OS media server. This address represents
one of two network addresses that are used for z/OS media server connectivity. In
the example, the HiperSockets connects the Tivoli Storage Manager server to the
z/OS media server. The zosMedServHiper server definition HLAddress of
HiperSockets defines the HiperSockets connection.

Both server definitions represent a single z/OS media server library resource. The
two PATH definitions reference the same library.

An important distinction between a Linux for System z storage agent and other
storage agents is the zosmediaserver parameter where each library path references
a specific z/OS media server name. The Tivoli Storage Manager server uses the
HiperSockets network and the SQL storage agent uses the external LAN network.
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The Tivoli Storage Manager server and Linux for System z storage agent both use
the HiperSockets network connection. The z/OS media server authenticates
incoming connections from the Tivoli Storage Manager server and storage agent by
using a single passphrase. Both server definitions must specify the same
serverpassword value. In Table 12 on page 74, the serverpassword value of
zosmedservpw must be specified for the z/OS media server PASSPHRASE option.

Installing and configuring software on client systems
You install storage agents and backup-archive or Tivoli Storage Manager Data
Protection clients on client systems. If you install a Data Protection application
client, you must also install the Tivoli Storage Manager API.

About this task

Install and configure the software by completing the following tasks:
1. “Installing and configuring the client”
2. For Data Protection application clients: “Installing and configuring the API” on

page 79
3. “Installing the storage agent” on page 80
4. “Configuring the storage agent” on page 85
Related concepts:
“Communications between the client, storage agent, and Tivoli Storage Manager
server” on page 8
Related tasks:
“Verifying and updating client node information” on page 52
“Verifying and updating client node information” on page 30
“Verifying and updating client node information” on page 78

Installing and configuring the client
The client can be a Tivoli Storage Manager backup-archive client or a Tivoli
Storage Manager Data Protection application client.

Before you begin

Before you begin this procedure, you must complete the following steps:
v Verify that the client system meets the prerequisites for client software. To

ensure software compatibility, check the website for Tivoli Storage Manager
storage agent and backup-archive client compatibility. You can download the
latest software levels from http://www.ibm.com/support/entry/portal/
Overview/Software/Tivoli/Tivoli_Storage_Manager.
For details about installing a backup-archive client, see the Backup-Archive Clients
Installation and User's Guide. For details about installing a Data Protection
application client, see the Data Protection Installation and User's Guides.

v Ensure that you completed the configuration worksheets.
v Ensure that client nodes are registered and configured on the server. To register

client nodes, use the REGISTER NODE or UPDATE NODE command.

Requirement: If multiple clients are moving data from a storage agent to a z/OS
media server, install or upgrade the client software on each client system.
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Procedure

Complete the following steps to install and configure the client:
1. Using the LAN-free communications protocol and LAN-free port information

that you collected in the configuration worksheets, modify the following file:
v dsm.sys client system-options file

Tip: The file can be in one of several places, such as the installation directory,
or in a location pointed to by an environment variable.
Select a communication method that you want the client and server to use. The
methods are described in Table 13, Table 14, and Table 15.

Table 13. Communications methods for a Tivoli Storage Manager server connecting to a
z/OS media server

To use this communication
method Configuration requirements

To connect to these Tivoli
Storage Manager servers

TCP/IP Install TCP/IP (standard with
supported operating systems)

AIX, Linux on System z

HiperSockets For details about configuring
HiperSocket connectivity
between Linux on System z and
z/OS, see the IBM Redbooks®

publication IBM HiperSockets
Implementation Guide. This
document is available online at
http://www.redbooks.ibm.com/
abstracts/sg246816.html

Linux on System z

Table 14. Communications methods from a storage agent to a z/OS media server

To use this communication
method Configuration requirements

To connect to these Tivoli
Storage Manager servers

TCP/IP Install TCP/IP (standard with
supported operating systems)

AIX, Linux x86_64, Linux on
System z, Linux on Power
Systems™, Solaris, Windows
Server

HiperSockets For details about configuring
HiperSocket connectivity
between Linux on System z and
z/OS, see the IBM Redbooks
publication IBM HiperSockets
Implementation Guide. This
document is available online at
http://www.redbooks.ibm.com/
abstracts/sg246816.html

Linux on System z

Table 15. Communications methods for the Tivoli Storage Manager client

To use this communication
method Install this software

To connect to these Tivoli
Storage Manager servers

TCP/IP TCP/IP (standard with
supported operating systems)

AIX, Linux x86_64, Linux on
System z, Linux on Power
Systems, Solaris, Windows
Server

Shared memory TCP/IP (standard with
platforms)

Linux x86_64, Linux on System
z, Linux on Power Systems

For example:
commmethod tcpip
tcpserveraddress server_c.example.com
tcpport 1502
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The preceding example uses a TCPPORT of 1502. However, the default
TCPPORT is 1500.

Restriction: The backup-archive client SERVERNAME option is not related to the
storage agent SERVERNAME option. For details, see the Backup-Archive Clients
Installation and User's Guide.

2. Install or upgrade the backup-archive client software or Data Protection
application-client software.

3. Add the following options to the same stanza in the same file that you edited
in step 1 on page 77. These options specify that the client uses SAN-attached
devices, when the path is available, during backup, restore, archive, and
retrieve processing.
TCP/IP Communications:
enablelanfree yes
lanfreecommmethod tcpip
lanfreetcpserveraddress agent.example.com
lanfreetcpport 1500

Shared memory:
enablelanfree yes
lanfreecommmethod SharedMem
lanfreeshmport 1510

What to do next

If you installed a Data Protection application client, you must install and configure
the API.
Related reference:
“Client-system and server-system configuration work sheets” on page 12
“Client-system and server-system configuration worksheets for z/OS Media” on
page 16
Related information:

Tivoli Storage Manager for Storage Area Networks support

Storage agent and client compatibility with Tivoli Storage Manager servers

Tivoli Storage Manager support

Verifying and updating client node information
When you configure LAN-free data movement, you must register client nodes and
provide policy information about client nodes. You can also restrict when a client
node uses a LAN-free path.

Procedure

Complete the following steps to verify client node information:
1. Identify the client node or nodes that uses the storage agent. In a typical

environment, a storage agent is used only by the client node that is on the
same system as the storage agent. However, you can configure two or more
client nodes to use the same storage agent.

2. Verify that the nodes are registered. If they are not registered, you must register
them. For details, see the Administrator's Guide.

3. Verify the policy information for the nodes. The copy group for backup and
archive must point to a storage pool that has a LAN-free path for a particular
storage agent. You define drive LAN-free paths and make them available for
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the storage pool. To view the destinations that are capable of LAN-free data
movement, you can issue the VALIDATE LANFREE command on the server. For
details about this command, see the Administrator's Reference.

4. After you verify the registration and policy information for the nodes, you can
place restrictions on when a node can use the LAN-free path. The node
attributes DATAWRITEPATH and DATAREADPATH determine the restriction that is
placed on the node:
v To use only the LAN-free path on backup and archive operations, specify

DATAWRITEPATH.

Important: Backup and archive operations can fail if the LAN-free path is
unavailable.

v To use the LAN path on restore and retrieve operations, specify
DATAREADPATH.

For more information about commands and their attributes, see the
Administrator's Reference.

Related tasks:
“Configuring multiple clients to use the same storage agent” on page 97
“Using LAN and LAN-free paths in the same backup operation” on page 97

Installing and configuring the API
If you are using a Tivoli Storage Manager Data Protection application client, you
must install and configure the Tivoli Storage Manager API.

Before you begin

Before you install and configure the API, verify that the client system meets the
prerequisites for the application programming interface (API) software. You can
download the latest software levels from the Tivoli Storage Manager product
support website.

For details about installing the API software, see the Backup-Archive Clients
Installation and User's Guide.

Requirement: If multiple Data Protection application clients are using LAN-free
data movement, configure the API on each client system.

Procedure
1. Install the Tivoli Storage Manager client API.
2. Specify the environment variables. The Tivoli Storage Manager API uses unique

environment variables to locate files.
v DSMI_CONFIG is the fully qualified name for the client user option file.
v DSMI_DIR points to the path that contains dsm.sys, dsmtca, and the

subdirectory en_US.
v en_US subdirectory must contain dsmclientV3.cat.
v DSMI_LOG points to the path for the dsierror.log file.

Tip: The quickest method to set the environment variables is to add these
variables to the user profile file.
The following examples show how to set up these environment variables in the
user profile:

Chapter 5. Installing and configuring the storage agent for data movement to a z/OS media server 79



export dsmi_config=/opt/tivoli/tsm/client/api/bin/dsm.opt
export dsmi_dir=/opt/tivoli/tsm/client/api/bin
export dsmi_log=/home/user_a/logdir

3. Edit an existing stanza or create a stanza in the dsm.sys file to specify the
communications options between the Tivoli Storage Manager API and server.
For example:
servername server_c
commmethod tcpip
enablelanfree yes
lanfreecommmethod tcpip
lanfreetcpserveraddress test.example.com
lanfreetcpport 1500
tcpport 1502
tcpserveraddress server_c.example.com

The example uses a TCPPORT of 1502. However, the default TCPPORT is 1500.
If a dsm.sys file does not exist in the directory that is specified by DSMI_DIR,
create a symbolic link to the dsm.sys file in the Tivoli Storage Manager client
installation directory. For example:
ln -s /opt/tivoli/tsm/client/ba/bin/dsm.sys

/opt/tivoli/tsm/client/api/bin/dsm.sys

Related reference:
“Client-system and server-system configuration work sheets” on page 12
“Client-system and server-system configuration worksheets for z/OS Media” on
page 16
Related information:

Tivoli Storage Manager for Storage Area Networks support

Storage agent and client compatibility with Tivoli Storage Manager servers

Tivoli Storage Manager support

Installing the storage agent
The storage agent can be found in the Tivoli Storage Manager installation package.
You can obtain the installation package from the product DVD or from an IBM
download site.

Before you begin

If you plan to download the files, set the system user limit for maximum file size
to unlimited to ensure that the files can be downloaded correctly.
1. To query the maximum file size value, issue the following command:

ulimit -Hf

2. If the system user limit for maximum file size is not set to unlimited, change it
to unlimited by following the instructions in the documentation for your
operating system.

About this task

If you obtain the package from the product DVD, ensure that the installation files
are visible on the DVD drive.

If you obtain the package from an IBM download site, you must extract the
installation files.

80 IBM Tivoli Storage Manager for SAN for Linux: Storage Agent User's Guide

http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/Tivoli_Storage_Manager_for_Storage_Area_Networks
http://www.ibm.com/support/docview.wss?uid=swg21302789
http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/Tivoli_Storage_Manager


Procedure
1. Download the appropriate package file from one of the following websites, or

you can access the files from the product DVD:
v For a first time installation or a new release go to Passport Advantage at:

http://www.ibm.com/software/lotus/passportadvantage/. Passport
Advantage is the only site that you can download a licensed package file
from.

v For the latest information, updates, and maintenance fixes, go to the Tivoli
Storage Manager support site: http://www.ibm.com/support/entry/portal/
Overview/Software/Tivoli/Tivoli_Storage_Manager.

2. If you download the package from one of the download sites, complete the
following steps:
a. Verify that you have enough space to store the installation files when they

are extracted from the product package.
b. Download the package file to the directory of your choice. The path must

contain no more than 128 characters. Be sure to extract the installation files
to an empty directory. Do not extract to a directory that contains previously
extracted files, or any other files.
Also, ensure that you have executable permission for the package file.

c. If necessary, change the file permissions by issuing the following command:
chmod a+x package_name.bin

d. Issue the following command to extract the installation files:
./package_name.bin

where package_name is like the following example:
7.1.0.000-TIV-TSMSRV-LinuxX64.bin
7.1.0.000-TIV-TSMSRV-LinuxS390X.bin

3. Select one of the following methods of installing the storage agent from the
Tivoli Storage Manager installation package:
v “Installing the storage agent by using the installation wizard” on page 55
v “Installing the storage agent by using console mode” on page 56
v “Installing the storage agent in silent mode” on page 57

Related reference:
“DSMSTA SETSTORAGESERVER command” on page 107

Installing the storage agent by using the installation wizard
You can install or update the storage agent by using the IBM Installation Manager
graphical wizard.

Before you begin

Ensure that you review the following important information about installing:
v Verify that the operating system is set to the language that you require. By

default, the language of the operating system is the language of the installation
wizard.

On test servers only: Use the following command to bypass prerequisite checks
such as the operating system and the required memory. Do not issue this
command on a production server.
./install.sh -g -vmargs "-DBYPASS_TSM_REQ_CHECKS=true"
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Procedure

Choose whether to install from a downloaded package file, or from the DVD, and
complete the following steps to begin the installation:

Option Description

Installing from a downloaded package file: 1. Change to the directory where you
downloaded the package file.

2. Start the graphical interface installation
wizard by issuing the following
command:

./install.sh

Installing from DVD media: 1. Insert the DVD into the DVD drive.
Tip: Ensure that the installation files are
visible on the DVD drive.

2. Start the graphical interface installation
wizard by issuing the following
command:

./install.sh

What to do next
v If errors occur during the installation process, these errors are recorded in log

files that are stored in the IBM Installation Manager logs directory.
You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

Related concepts:
“Software requirements” on page 7
Related information:

Tivoli Storage Manager for Storage Area Networks support

Passport Advantage download document

Installing the storage agent by using console mode
You can install or update the storage agent by using the command line in console
mode.

Before you begin

Ensure that you review the following important information about installing:
v Verify that the operating system is set to the language that you require. By

default, the language of the operating system is the language of the installation
wizard.

On test servers only: Use the following command to bypass prerequisite checks
such as the operating system and the required memory. Do not issue this
command on a production server.
./install.sh -c -vmargs "-DBYPASS_TSM_REQ_CHECKS=true"
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Procedure

Choose whether to install from a downloaded package file, or from the DVD, and
complete the following steps to begin the installation:

Option Description

Installing from a downloaded package file: 1. Change to the directory where you
downloaded the package file.

2. Start the installation wizard in console
mode, by issuing the following
command:

./install.sh -c

You can generate a response file as part
of a console mode installation. Complete
the console mode installation options,
and in the Summary panel, specify G to
generate the responses.

Installing from DVD media: 1. Insert the DVD into the DVD drive.
Tip: Ensure that the installation files are
visible on the DVD drive.

2. Start the installation wizard in console
mode, by issuing the following
command:

./install.sh -c

You can generate a response file as part
of a console mode installation. Complete
the console mode installation options,
and in the Summary panel, specify G to
generate the responses.

What to do next
v If errors occur during the installation process, these errors are recorded in log

files that are stored in the IBM Installation Manager logs directory.
You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

Related concepts:
“Software requirements” on page 7
Related information:

Tivoli Storage Manager for Storage Area Networks support

Passport Advantage download document

Chapter 5. Installing and configuring the storage agent for data movement to a z/OS media server 83

http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/Tivoli_Storage_Manager_for_Storage_Area_Networks
http://www.ibm.com/support/docview.wss?uid=swg24030391


Installing the storage agent in silent mode
You can install or update the storage agent in silent mode without any user
interaction.

Before you begin

A silent installation can use response files for data input. The following sample
response files are provided for installing, updating, and uninstalling Tivoli Storage
Manager:
v install_response_sample.xml

v update_response_sample.xml

v uninstall_response_sample.xml

If you want to use one of the sample response files, they can be found after you
extract the package files, in the input subdirectory. You can use these sample files
as they are or you can customize them to suit your needs. It is optimal to use the
sample response files. These sample files contain instructions and default values to
help you avoid any unnecessary warnings.

On test servers only: Use the following command to bypass prerequisite checks
such as the operating system and the required memory. Do not issue this
command on a production server.

./install.sh -s -acceptLicense -vmargs "-DBYPASS_TSM_REQ_CHECKS=true"

Procedure
1. Create a response file, or use one of the sample response files such as

install_response_sample.xml or update_response_sample.xml.
2. To start the silent installation, issue one of the following commands from the

directory where the installation package file is extracted:

Option Description

Installing from a
downloaded package file or
DVD media:

To start the installation by accepting the default values,
issue the following command:

./install.sh -s -acceptLicense

To start the installation with a custom response file, issue
the following command, where response_file represents the
response file path, including the file name:

./install.sh -s -input response_file -acceptLicense

What to do next
v If errors occur during the installation process, these errors are recorded in log

files that are stored in the IBM Installation Manager logs directory.
You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

Related concepts:
“Software requirements” on page 7
Related information:

Tivoli Storage Manager for Storage Area Networks support

Passport Advantage download document
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Defining and configuring the storage agent
You must define and configure the storage agent to communicate with the
backup-archive client and the Tivoli Storage Manager server.

Defining storage agents to the Tivoli Storage Manager server
For each client that uses storage agent data transfer, define a storage agent to the
server.

Before you begin

Use the same name and password that you specified for the storage agent when
you installed it on the client system.

Procedure
1. Define the storage agent by issuing the DEFINE SERVER command from the

Tivoli Storage Manager server that manages the client's data. For example:
define server storagnt serverpassword=fun4me
hladdress=agent.tucson.ibm.com lladdress=1500 validateprotocol=all

The VALIDATEPROTOCOL parameter in the example is optional. This parameter
specifies whether a cyclic redundancy check is run to validate data on all
metadata that is transferred between the storage agent and the Tivoli Storage
Manager server.
For details about data validation, see the Administrator's Guide. For details
about the DEFINE SERVER command, see the Administrator's Reference.

2. Verify that the storage agent is defined to the library manager by issuing the
following command from the library-manager server:
query server server_name format=detailed

Important: If the library-manager server is different from the library-client
server that hosts the storage agent, define the storage agent as a server on both
the library-manager server and the library-client server. The storage agent must
be able to contact the library manager directly when it makes mount requests.
If the storage agent is only defined to the library client, it attempts to use
information from the library client to define itself to the library manager.

What to do next

You can complete the steps in “Configuring the storage agent.”

Configuring the storage agent
After the installation is completed, you must configure the storage agent to ensure
communication with the backup-archive client and the Tivoli Storage Manager
server. The z/OS media server must be configured to access the Tivoli Storage
Manager server.

Procedure

Complete the following steps to configure the storage agent:
1. Point the server to the storage agent by issuing the DEFINE SERVER command on

the Tivoli Storage Manager server.
2. Complete the steps in “Defining storage agents to the Tivoli Storage Manager

server.”
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3. To ensure communication between the storage agent and devices and libraries
that are controlled by the z/OS media server, complete the steps in “Defining
paths from the storage agent to the z/OS media server” on page 88.

4. Ensure that the DEVCONFIG option is specified in the storage agent options file
dsmsta.opt.
For example, for a device configuration file named devconfig.out, edit the
dsmsta.opt file by typing the following line:
DEVCONFIG devconfig.out

The device configuration file can be in the following directory:
/opt/tivoli/tsm/StorageAgent/bin

5. Use the information that you collected in the configuration worksheets to issue
the DSMSTA SETSTORAGESERVER command. For example:
dsmsta setstorageserver myname=storagnt mypassword=fun4me
myhladdress=agent.example.com
servername=tsmsrver serverpassword=not4u
hladdress=tsmsrver.example.com lladdress=1502

Requirement:

v The SERVERNAME option in the dsm.sys file, which is the client system options
file, must match the SERVERNAME option in the dsm.opt file, which is the client
user-options file. However, the option is unrelated to and does not need to
match the SERVERNAME option that is defined for the storage agent in the
storage-agent options file, dsmsta.opt.

v The HLADDRESS option must match the TCPSERVERADDRESS option that is in the
dsm.sys file on the Tivoli Storage Manager client. When you configure the
storage agent by using the DSMSTA SETSTORAGESERVER command, use
addresses that correspond to the communications method used by the
backup-archive client. With the backup-archive client, you can use either IPv4
(COMMMETHOD TCPIP option) or IPv6 (COMMMETHOD V6TCPIP option), but not both
at the same time. To secure communication between the storage agent and
the Tivoli Storage Manager server, ensure that your data is protected by
Secure Sockets Layer (SSL).

The DSMSTA SETSTORAGESERVER command generates the following output in the
storage agent device configuration file:
set staname storagnt
set stapassword xxxxxxx
set stakeydbpw xxxxxxx
set stahladdress agent.example.com
define server tsmsrver serverpassword=xxxxxxxxxxx
hladdress=tsmsrver.example.com lladdress=1502

The passwords (shown as xxxxxxxxxxx) are encrypted in the file.
The command also generates the following line in the dsmsta.opt file:
SERVERNAME tsmsrver

Related reference:
“Client-system and server-system configuration work sheets” on page 12
“Storage agent options file” on page 102
“DSMSTA SETSTORAGESERVER command” on page 107
“The device configuration file for the storage agent” on page 101
Related information:

Tivoli Storage Manager for Storage Area Networks support

Storage agent and client compatibility with Tivoli Storage Manager servers
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Tivoli Storage Manager support

Setting up storage agent data transfer on the Tivoli Storage Manager
server

To set up storage agent data transfer on the Tivoli Storage Manager server, you
must set up server-to-server communication and define the path for the storage
agent that is installed on the client to the server.

Before you begin

Before set up the storage agent data transfer, ensure that you have the information
that is recorded in the configuration-information worksheets.

About this task

Perform these tasks to set up server-to-server communication and configure
devices on the server:
1. “Setting up server-to-server communication”
2. “Defining paths from the storage agent to the z/OS media server” on page 88
3. “Confirming client node registration and configuration” on page 89

Setting up server-to-server communication
You must set up server-to-server communication to enable the Tivoli Storage
Manager servers and storage agents to access z/OS media server storage.

Procedure

Set up server-to-server communication by issuing the following commands on the
Tivoli Storage Manager server. Replace the values in the example with values from
the configuration-information worksheet.
set servername tsmsrver
set serverpassword not4u
set serverhladdress tsmsrver.example.com
set serverlladdress 1502
set crossdefine on

Results

These commands establish the name, password, TCP/IP address, and port, of the
server. They also allow other servers to define a connection on this server.

What to do next

Verify that the password is set for the server by issuing the QUERY STATUS
command from a Tivoli Storage Manager administrative command line. The value
of the Server Password Set field in the command output must be YES.

See the Administrator’s Guide for details about the following tasks:
v Defining media resources to access the Tivoli Storage Manager server
v Server-to-server communication
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Defining paths from the storage agent to the z/OS media
server

You must define a path from the storage agent to the z/OS media server library
resource. A z/OS media server can manage both FILE and TAPE volume resources.

Procedure

Define a path for a z/OS media library by using the DEFINE PATH command. For
example, to define a path to a z/OS media library, that contains 3592 devices:
define path sta1 zos3592lib srctype=server desttype=library zosmediaserver=srv1zos

The zosmediaserver=srv1zos server definition is also defined between the Tivoli
Storage Manager server and the z/OS media server.

What to do next

For details about the DEFINE PATH command, see the Administrator's Reference.

Setting the storage agent data transfer destination
You must set the storage agent data transfer destination to enable data transfer
between the storage agent and the z/OS media server. The destination for data
must be a LAN-free capable storage pool.

Procedure

Set a LAN-free destination by completing the following steps:
1. Define a copy group with a destination to a LAN-free capable storage pool. For

example:
define copygroup zosdirect zosdirectpolicy zosdirectdefmgt

type=backup destination=storage_pool_name

2. Activate the policy set. For example:
activate policyset zosdirect zosdirectpolicy

What to do next

For details about changing policy for clients that can use z/OS media server
access, see the Administrator's Guide. For details about the commands, see the
Administrator's Reference.

Note:

v If you do not want to use the default management class for z/OS media server
access, create a management class.
For details about the include-exclude list, see the Backup-Archive Clients
Installation and User's Guide.

v With a hierarchical storage management client configured for storage agent data
transfer, the management class (not the copy group) is set to a LAN-free capable
storage pool.
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Confirming client node registration and configuration
Client nodes must be registered and configured for LAN-free backups.

Procedure

Verify that node settings are correct by issuing the following command:
query node node_name format=detailed

What to do next

If node settings are not correct, issue the UPDATE NODE command to adjust settings
for the node. If the node is not registered and configured for LAN-free backups,
register the node with the REGISTER NODE command.

To help tune the use of your server LAN and z/OS media server LAN resources
for storage agent data transfer, you can control the path that data transfers take for
clients that have LAN-free data movement capability. For each client, you can
select whether data read/write operations use the server LAN path, the z/OS
media server LAN path, or either path. You can specify these settings with the
REGISTER NODE and UPDATE NODE commands.

If the node belongs to a multi-threaded client and there are drives available, the
MAXNUMMP parameter might restrict the number of drives that are available for the
storage agent to use on behalf of the client. Specify the MAXNUMMP parameter on the
REGISTER NODE or UPDATE NODE command.

For details about commands, see the Administrator's Reference.

Verifying the storage agent configuration
To ensure that the storage agent is moving data to the z/OS media server, you
must verify that the hardware and software components are configured correctly.

Procedure

Verify the storage agent configuration by completing the following steps:
1. Start the storage agent:

Change to the storage agent directory and issue the DSMSTA command.
When the storage agent starts, it contacts all available shared libraries,
including those libraries that do not have a defined path. As a result, a delay
might occur during startup processing. The storage agent also determines if the
Tivoli Storage Manager server is a library client or library manager. If the
server is a library client, the storage agent attempts to define itself to the library
manager if it is not known to the library manager. When the storage agent
communicates with the Tivoli Storage Manager server, Secure Sockets Layer
(SSL) information is displayed to indicate that SSL is in use.

2. Run a backup operation from the client.
3. Log on to the Tivoli Storage Manager server and storage agent by using a

Tivoli Storage Manager administrative command-line client.
4. Verify that the storage agent is moving the backup data to the z/OS media

server and the sessions are established by issuing the QUERY SESSION command.
In the command output, look for information about bytes sent and bytes
received. If the storage agent is successfully moving the data, complete the
following steps:
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v Querying a session on the storage agent shows bytes received for the node
that is increasing to the total amount of data that is backing up.

v Querying a session on the Tivoli Storage Manager server shows a few bytes
(metadata) received for the same node.

If the node's session has these characteristics, and you receive a message that
states that the backup was successful, you configured your system correctly.
There are several ways to query a session. If the process is running in the
foreground, you can issue the QUERY SESSION command on the storage agent
console. Alternatively, you can use a command-line client to connect to the
storage agent on the administration port of the storage agent. Use the same
administrator ID and password for this command that you use on the server.

5. If you receive a message that states that the backup failed, verify the following
tasks:
v The Tivoli Storage Manager server is running. If the Tivoli Storage Manager

server is not running, the storage agent will not start.
v The z/OS media server is available and accessible from the storage agent.
v The client, storage agent, and server are communicating with each other.
v The mount and message are displayed on the storage agent console.

If you try the backup operation again after the first failure, the client attempts
to use the LAN connection for data movement. To force data movement from
the storage agent to the z/OS media server, stop and restart the client.

Determining whether the storage agent moves data
To ensure data transfer from the storage agent to the z/OS media server, you must
verify the network connectivity and the Tivoli Storage Manager software
components.

About this task

Messages and backup reports can indicate whether the storage agent is moving
data to the z/OS media server successfully. You can also use the QUERY SESSION
and QUERY ACTLOG commands to verify data movement.

Procedure

To determine whether the storage agent moves the data, use one or both of the
following methods:
v Monitor the QUERY SESSION output against the node that is running the backup

from the storage agent to the z/OS media server. Verify that the proper sessions
are established:
1. Log in to the Tivoli Storage Manager server and storage agent by using a

Tivoli Storage Manager administrative command-line client.
2. Verify that the storage agent is moving the backup data to the z/OS media

server and the proper sessions are established, issue the QUERY SESSION
command. In the command output, look for information about bytes sent
and bytes received. If data movement is occurring, complete the following
steps:
– Query a session on the storage agent to show the bytes received for the

node that increases to the total amount of data that is backed up.
– Query a session on the Tivoli Storage Manager server to show a small

number of bytes (metadata) received for the same node.
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If the node session shows these characteristics, the storage agent is moving data
to the z/OS media server.

Tip: During a failover where the storage agent is sending data directly to the
server by proxy because it cannot store the data directly, the QUERY SESSION
statistics on the server show a much higher byte count.

v Issue either of the following QUERY ACTLOG commands on the server to which the
client is connected:
query actlog search=storage_agent_name

If the query locates entries in the activity log that relate to the storage agent, the
client is transferring data to the z/OS media server.

Related information:
Connecting to a Tivoli Storage Manager storage agent by using an administrative
command-line client
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Appendix A. Starting and stopping the storage agent

You can configure the storage agent to start automatically when the system
restarts. You can also start and stop the storage agent manually.

Automating the storage agent startup
You can configure the storage agent to start automatically when the system
restarts.

Procedure
1. Log in to the system with the root user ID.
2. Copy the file dsmsta.rc from the directory where the storage agent is installed

to the /etc/init.d directory. For example:
cp /opt/tivoli/tsm/StorageAgent/bin/dsmsta.rc /etc/init.d

3. Ensure that the file has the execute permission. For example:
chmod 755 /etc/init.d/dsmsta.rc

4. Issue the following chkconfig commands to automatically start the storage
agent on run levels 3 and 5:
chkconfig --add dsmsta.rc
chkconfig --level 35 dsmsta.rc on

Requirement: The script must exist in the /etc/init.d directory to run the
chkconfig commands.

Manually starting and stopping the storage agent
You can start and stop the storage agent from the storage agent directory. You can
also use an administrative client to issue commands that are supported by the
storage agent.

About this task

To start the storage agent:
1. Open the operating system command line and change to the storage agent

directory (the default is /opt/tivoli/tsm/StorageAgent/bin).
2. Issue the DSMSTA command.

Stop the storage agent by typing the following command at the Storage Agent
(STA) command-line prompt:
halt

In most cases, it is not necessary to stop and restart a LAN-free storage agent to
pick up changes from the data manager server. However, restarting the storage
agent might be necessary if you changed the storage pool, library, device class, or
drive information while LAN-free data movement was in process.

The storage agent keeps a list of storage pools, libraries, and device classes in
memory to determine potential LAN-free destinations. The target volume and
library selection occurs on the data manager server.
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Certain storage pool attributes can result in failed requests rather than the LAN
failover by the storage agent. If the storage agent has a LAN-free path that is
established to the storage device, failover will not occur. However, if the storage
agent incorrectly identifies a LAN-free destination and the server is unable to
process the request, the operation advances beyond the point when LAN failover
occurs, and the storage agent request does not succeed. If the storage agent request
is unsuccessful, stop and restart the storage agent, and try the operation again.
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Appendix B. Connecting to a Tivoli Storage Manager storage
agent by using an administrative command-line client

You can use a command-line client to connect to the storage agent on the
administration port of the storage agent.

Connecting to a Tivoli Storage Manager storage agent by using an
administrative command-line client

You can configure the administrative command-line client to communicate directly
with a storage agent and issue commands that are supported by the storage agent.

Procedure
1. Configure the administrative command-line client by defining the following

options in the dsm.sys file for the storage agent:

Tip: In this configuration example, the storage agent is on agent.example.com.
servername storageagent
commmethod tcpip
tcpport 1500
tcpserveraddress agent.example.com

2. Start the administrative client and specify the following command:
dsmadmc -se=storageagent

Requirement: Your user ID and password must be registered with the server.
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Appendix C. Customizing the storage agent environment

You can customize the storage agent for specialized tasks.

Configuring multiple clients to use the same storage agent
You can configure two or more clients to use the same storage agent.

Procedure

To configure the clients:
v If the clients are on the same system as the storage agent, set the appropriate

options and values in the client dsm.sys file.
v If the clients are not on the same system as the storage agent, set the following

options with the appropriate values:
– LANFREECOMMMETHOD TCPIP

– LANFREETCPSERVERADDRESS

Specify the TCP/IP address of the system where the storage agent is installed.
– LANFREETCPPORT

Specify the same TCP/IP port address as specified by the TCPPORT option in
the storage agent options file dsmsta.opt.

Using LAN and LAN-free paths in the same backup operation
During a single client backup operation, you can send some of the data over a
LAN-free path and some of the data over a LAN path.

Before you begin

Before beginning this procedure:
v Ensure that the values for the DATAWRITEPATH and DATAREADPATH in client node

definition are set to ANY. Use the server command REGISTER NODE or UPDATE
NODE to set the parameter values.

v Ensure that the active policy set of the domain to which the client is registered
has at least two management classes. One of the management classes must point
to a destination storage pool that is enabled for LAN-free data movement. The
other management class must point to a destination storage pool that is not
enabled for LAN-free data movement.

v Ensure that ENABLELANFREE=YES is set in the following file:
dsm.sys (server stanza)

Procedure

Send data over LAN and LAN-free paths in the same backup operation by
completing the following steps:

Specify client include statements that bind data that requires the LAN-free path to
the management class that uses a LAN-free-enabled storage pool. Specify separate
client include statements that bind data that requires the LAN path to a
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management class that does not use a LAN-free enabled storage pool. The include
statements are located in the following file:

The file that is specified with the inclexcl client option

Tip: If the default management class for the policy set does not specify a
LAN-free-enabled storage pool, you can omit the include statement for the LAN
data path. You can omit the include statement because the data that is not bound
by an include statement is bound to the default and sent over the LAN.

ACSLS legacy data migration and coexistence
If StorageTek Automated Cartridge System Library Software (ACSLS)
shared-library support is not possible in your configuration, data migration is
required.

If your environment consists of Tivoli Storage Manager storage pools that are
associated with an ACSLS library type and an ECARTRIDGE device type, the
library can be updated with the SHARED=YES option to enable LAN-free data
movement. However, if your environment consists of Tivoli Storage Manager
storage pools that are associated with an ACSLS library type and a GENERICTAPE
device type, data migration is required rather than coexistence because Tivoli
Storage Manager ACSLS shared library support cannot co-exist with external
library support.

Data migration of ACSLS to external library support is necessary only when Tivoli
Storage Manager ACSLS shared library support is not possible in your
configuration. The only situation where ACSLS shared library support is not
possible is when your environment does not contain a Tivoli Storage Manager
server that is installed on AIX, Solaris, or Windows to serve as the library manager.
Migrate the existing data from existing (old) storage pools to new storage pools
associated with the appropriate policy, device class, and library definitions.
Migration of data also allows the entire environment to be LAN-free, providing
better performance, and better utilization of tape drives and media.

Figure 14 on page 99 displays the normal migration path from an old storage pool
that contains the data that is associated with the ACSLS library type to a new
storage pool associated with an EXTERNAL library type and an ECARTRIDGE
device class.
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Two methods to migrate data are:
v Use the IBM Tivoli Storage Manager server MOVE DATA command. This

method allows the legacy ACSLS data to move to a new storage pool without
moving any expired files in the aggregates. For more information, see the
Administrator's Guide.

v Use the IBM Tivoli Storage Manager server storage pool reclamation function.
This method works by reclaiming the active files from the legacy ACSLS storage
pools. Reclamation processing, however, is very resource-intensive and should
be performed during periods of little activity on the server. For more
information, see the Administrator's Guide.

For detailed information about how to migrate from an external library
environment to a shared ACSLS library environment, see the Administrator's Guide.
Related concepts:
“External libraries” on page 22

Old Storage
Pool

Migration

Device Class

device type = generictape

library type = ACSLS

Device Class

device type = ecartridge

library type = EXTERNAL

New Storage
Pool

Figure 14. Legacy ACSLS data migration
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Appendix D. Storage agent commands and configuration files

Use files and commands to administer and configure the storage agent and
devices.

The device configuration file for the storage agent
The device configuration file for the storage agent includes information about the
storage agent and the Tivoli Storage Manager server with which the storage agent
communicates.

The file is typically named devconfig and is located with the storage agent
program:

/opt/tivoli/tsm/StorageAgent/bin

The DSMSTA SETSTORAGESERVER command normally generates the contents of the
file, and you can also use the command to add information to the file.

Typical contents of the device configuration file are as follows:
set staname storagnt
set stapassword fun4me
set stakeydbpw password
set stahladdress agent.example.com
define server tsmsrver serverpassword=not4u

hladdress=tsmsrver.example.com lladdress=1502

In this example, storagnt is the name of the storage agent and tsmsrver is the name
of the Tivoli Storage Manager server.

Properties

SET STANAME
Sets the name of the storage agent. The name must be the same as the
name that was used to define the storage agent as a server to the Tivoli
Storage Manager server.

SET STAPASSWORD
Sets the password of the storage agent. The password must be the same as
the password that was used when you define the storage agent as a server
to the Tivoli Storage Manager server. The password is encrypted.

SET STAKEYDBPW
Sets the password that is used to verify and control access to the Secure
Sockets Layer (SSL) database. The password is obfuscated and stored in
the storage agent options file.

SET STAHLADDRESS
Sets the TCP/IP address of the storage agent.

DEFINE SERVER
Define the Tivoli Storage Manager server with which the storage agent
communicates.

© Copyright IBM Corp. 2000, 2013 101



Storage agent options file
The storage agent options file contains the name of the server with which the
storage agent communicates, along with other options. Normally, do not change
the options file unless your Tivoli Storage Manager server changes.

The options file for the storage agent is named dsmsta.opt. The dsmsta.opt file is
located where the storage agent program was installed. The options file is stored in
the following default path:

/opt/tivoli/tsm/StorageAgent/bin

For detailed information about these options, see the Administrator's Reference.

For detailed information about the COMMMETHOD and LANFREECOMMMETHOD options, see
the Backup-Archive Clients Installation and User's Guide.

Required options

DEVCONFig file_name
The name of the device configuration file for the storage agent. A typical
name for the file is devconfig.

SERVERName server_name
The name of the Tivoli Storage Manager server with which the storage
agent communicates. The DSMSTA SETSTORAGESERVER command inserts this
option.

TCPPort number

Specifies the port number on which the server TCP/IP communication
driver is to wait for requests for client sessions.

Use different port numbers for the options TCPPORT and TCPADMINPORT to
create one set of firewall rules for client sessions and another set for other
session types (administrative sessions, server-to-server sessions, SNMP
subagent sessions, storage agent sessions, library client sessions, managed
server sessions, and event server sessions). If the two port numbers are
different, separate threads are used to service client sessions and the other
session types. If you allow the two options to use the same port number
(by default or by explicitly setting them to the same port number), a single
server thread is used to service all session requests.

Additional options

ADMINONClientport
Specifies whether the TCPPORT can be used by administrative sessions. You
can specify one of the following values:

YES (default)
If the option is set to YES, or if the TCPPORT and TCPADMINPORT are the
same value (the default), then the administrative sessions can use the
TCPPORT.

NO If the option is set to NO, and if the TCPADMINPORT value is different
from the TCPPORT value, then administrative sessions cannot use
TCPPORT.

CHECKTAPEPOS
Specifies whether the Tivoli Storage Manager server validates the position
of data blocks on tape. The CHECKTAPEPOS option applies only to operations
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by using tape drives. It does not apply to non-tape, sequential-access
device classes such as FILE. If the server information about the position
does not match the position that is detected by the drive, an error message
is displayed, the transaction is rolled back, and the data is not committed
to the database.

The default is YES.

The following options are available:

Yes
Specifies that the Tivoli Storage Manager server validates data position
on tape. For drives that support append-only mode, this parameter
specifies that Tivoli Storage Manager enables the drive to also validate
the data position during each WRITE operation to prevent data
overwrite.

No Specifies that all data position validation is turned off.

TSMonly
Specifies that the Tivoli Storage Manager server validates data position
on tape. The server does not use append-only mode even if the drive
supports the feature.

DRIVEonly
Specifies that the Tivoli Storage Manager server enables append-only
mode for drives that support this feature. The server does not validate
the data position on tape.

COMMTimeout seconds
Specifies the maximum number of seconds that the server waits for an
expected client message during an operation that causes a database update.
The default value is 60. The minimum value is 1. If the length of time
exceeds the timeout, the server ends the session with the client. You might
want to increase the timeout value to prevent clients from timing out.
Clients might time out if there is a heavy network load in your
environment or when they are backing up large files.

IDLETimeout minutes
Specifies the maximum number of minutes that a client session can be idle
before the server cancels the session. The default value is 15 minutes. The
minimum value is 1 minute. You might want to increase the timeout value
to prevent clients from timing out if there is a heavy network load in your
environment. Note, however, that many idle sessions might prevent other
users from connecting to the server.

MAXSessions number_of_sessions
Specifies the maximum number of simultaneous client sessions that can
connect with the server. The default value is 25 client sessions. The
minimum value is 2 client sessions. The maximum value is limited only by
available virtual memory size or communication resources.

MSGSTACKTRACE on|off
Specifies that a list of functions will be shown on the server console, and
will also be directed to the activity log after specific messages are issued.
The output helps the Tivoli Storage Manager service team to diagnose
specific problems quicker. It is best practice that this option is set to ON.
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RESOURCETimeout minutes
Specifies the maximum number of minutes that a storage agent waits for a
resource on the server. The default value is 60 minutes. The minimum
value is 1 minute.

For database resources and sessions on the storage agent, the Tivoli Storage
Manager resource monitor picks the shortest timeout value to start a
recovery process.

In contrast, in the case of library sharing, the resource monitor picks the
longest time for both the library manager and library client to recover. For
more efficient management of shared library resources, consider setting
resource timeouts at the same limit for all participants in a shared
configuration. In any case of error recovery, Tivoli Storage Manager always
defers to the longest timeout limit.

You should also specify this option in the server options file. The server
uses this option to monitor some of the storage agent sessions and
resources and cancel sessions that are based on the value you specify.

Important: If this option is specified in the server options file, that value
overrides the value that is specified in the storage agent's options file.

SANDISCOVERY
Specifies whether the Tivoli Storage Manager SAN discovery function is
enabled. When set to ON, the storage agent uses SAN discovery in the
following instances:
v During storage agent initialization
v When the device path is changed and there is a conflict between the

device serial number and the device path that is provided by the server

SANDISCOVERY OFF is the default value for AIX, Linux, HP-UX, Oracle
Solaris, and 64-bit Microsoft Windows.

The following options are available:

ON Specifies that the server uses SAN discovery when the device path is
changed, or when the QUERY SAN command is issued.

OFF
Disables the SAN discovery function but does not take the device path
offline. Set the SANDISCOVERY option to OFF if the HBA used by the
storage agent does not support SAN device mapping.

UNSCANNEDPATHOFF
Disables the SAN discovery function and takes the device path offline
if the server is unable to open it.

Using SAN discovery, the storage agent can automatically correct the
special file name of the device if it is changed. If the HBA used by the
storage agent does not support SAN device mapping, set the SANDISCOVERY
option to OFF.

For information about Tivoli Storage Manager supported HBAs for SAN
device mapping, see the Tivoli Storage Manager for Storage Area Networks
support site at http://www.ibm.com/software/sysmgmt/products/
support/IBMTivoliStorageManager.html.

The storage agent does not require persistent binding with the SAN
discovery function enabled.
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To help with problem determination, you can use the dsmsanlist module
to obtain information about devices on a storage area network (SAN). The
dsmsanlist module is installed by default when the Tivoli Storage Manager
storage agent is installed.

SSLTCPADMINPORT
Specifies the port address on which the server TCP/IP communication
driver waits for requests for sessions that are enabled by Secure Sockets
Layer (SSL). The sessions are for the command-line administrative client.

When you use the SSLTCPADMINPORT or SSLTCPPORT option and start the
server, a key database file cert.kdb is created. The key database file is
created in the server instance directory and is initialized with a self-signed
certificate.

The following types of sessions do not use SSL:
v NDMP (Network Data Management Protocol)
v ACSLS (Automated Cartridge System Library Software)
v SNMP (Simple Network Management Protocol) subagent

If the ADMINONCLIENTPORT option is set to NO, SSL-enabled sessions for the
administrative client require SSLTCPADMINPORT with a port number other
than one specified by the SSLTCPPORT option. The SSLTCPADMINPORT option
does not affect the TCPPORT or TCPADMINPORT options and their interaction
with the ADMINONCLIENTPORT option.

The TCP/IP communications driver must be enabled with COMMMETHOD
TCPIP or COMMMETHOD V6TCPIP.

SSLTCPPORT
Specifies the Secure Sockets Layer (SSL) port number. The server TCP/IP
communication driver waits for requests on this port for SSL-enabled
sessions from the client.

The following types of sessions do not use SSL:
v NDMP (Network Data Management Protocol)
v ACSLS (Automated Cartridge System Library Software)
v SNMP (Simple Network Management Protocol) subagent
v Database restore operations

If the ADMINONCLIENTPORT option is set to NO, SSL-enabled sessions for the
administrative client require the SSLTCPADMINPORT option with a port
number different from one specified by the SSLTCPPORT option. The
SSLTCPPORT option does not affect the TCPPORT or TCPADMINPORT options and
their interaction with the ADMINONCLIENTPORT option.

The TCP/IP communications driver must be enabled in the appropriate
client options file with COMMMETHOD TCPIP option or COMMMETHOD V6TCPIP
option. The backup-archive client supports either the COMMMETHOD TCPIP
option or the COMMMETHOD V6TCPIP option, but not both at the same time.

STAKEYDBPW
Specifies the password that is used to verify and control access to the SSL
key database. The user cannot edit the value of STAKEYDBPW.

STAMaxpooledsessions number
Specifies the number of individual sessions that are allowed to start and
stop between the storage agent and the Tivoli Storage Manager server. The
range of values is 0 - 150, with a default of 25. Each session is governed by
the IDLETIMEOUT option and is stopped when the timeout value is
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exceeded. If the storage agent needs more sessions than specified, extra
sessions are allowed. Although the default value is typically sufficient,
setting this option with a low number can adversely affect performance. If
the storage agent has multiple client sessions, increasing the value of this
option helps to support these sessions.

TCPADMINPORT number

Specifies the port number on which the server TCP/IP communication
driver is to wait for requests for sessions other than client sessions.
Non-client sessions include administrative sessions, server-to-server
sessions, SNMP subagent sessions, storage agent sessions, library client
sessions, managed server sessions, and event server sessions. The default is
the value of TCPPORT.

Use different port numbers for the options TCPPORT and TCPADMINPORT to
create one set of firewall rules for client sessions and another set for the
other non-client session types. By using the SESSIONINITIATION parameter
of REGISTER NODE and UPDATE NODE, you can close the port that is specified
by TCPPORT at the firewall, and specify nodes whose scheduled sessions are
started from the server. If the two port numbers are different, separate
threads are used to service client sessions and the session types. If you
allow the two options to use the same port number (by default or by
explicitly setting them to the same port number), a single server thread is
used to service all session requests.

Client sessions that attempt to use the port that is specified by
TCPADMINPORT is terminated (if TCPPORT and TCPADMINPORT specify different
ports). Administrative sessions are allowed on either port, (unless the
ADMINONCLIENTPORT option is set to NO) but by default uses the port that is
specified by TCPADMINPORT.

THROUGHPUTDatathreshold kilobytes_per_second
Specifies the throughput that client sessions must achieve to prevent
cancellation after THROUGHPUTTIMETHRESHOL minutes elapses. The default
value of 0 prevents examining client sessions for insufficient throughput.
Throughput is computed by adding the send and receive byte counts and
dividing by the length of the session. The length does not include time that
is spent waiting for media mounts and starts at the time a client sends
data to the server for storage. The minimum value is 0; the maximum is
99999999.

THROUGHPUTTimethreshold minutes
Specifies the threshold for examining client sessions and canceling them if
the data throughput threshold is not met (see THROUGHPUTDATATHRESHOLD).
This threshold does not include time that is spent waiting for media
mounts. The time threshold starts when a client begins sending data to the
server for storage (as opposed to set up or session housekeeping data). The
default value of 200 prevents examining client sessions for low throughput.
The minimum value is 0; the maximum is 99999999.

USELARGEBUFFERS yes|no
Specifies that large buffers are used for client/server communications. The
default of YES specifies that large buffers are used; NO specifies that they
are not used.
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DSMSTA SETSTORAGESERVER command
Use the DSMSTA SETSTORAGESERVER command to initialize the storage agent and add
communication information to the device configuration file and the storage agent
options file dsmsta.opt.

Use this utility on the client system where the storage agent is installed.

This utility does not remove any previous entries in the files. It appends
information to the existing files. The option DEVCONFIG, which sets a name for the
device configuration file, must be in the dsmsta.opt file for the command to work.
See “Examples” on page 108.

When you configure the storage agent by using the DSMSTA SETSTORAGESERVER
command, use addresses that correspond to the communications method used by
the backup-archive client. The backup-archive client supports either IPv4
(COMMMETHOD TCPIP) or IPv6 (COMMMETHOD V6TCPIP), but not both at the same time.

Syntax

�� DSMSTA SETSTORAGESERVER MYName = storage_agent_name �

� MYPAssword = storage_agent_password �

� MYHLAddress = storage_agent_hladdress SERVERName = server_name �

� SERVERPAssword = server_password HLAddress = server_tcpip_address �

� LLAddress = server_tcpip_port STAKEYDBPW = obfuscated_password �

� SSL = YES ��

Parameters

All parameters are required. Allowed abbreviations for the options are shown in
uppercase letters.

MYName
Specifies the name of the storage agent. This name is displayed in the SET
STANAME command that is inserted into the device configuration file.

You must use the same name when you define the storage agent as a server to
the Tivoli Storage Manager server.

MYPAssword
Specifies the password of the storage agent. This value is encrypted and used
in the SET STAPASSWORD command that is inserted into the device configuration
file.

You must use the same password when you define the storage agent as a
server to the Tivoli Storage Manager server.

MYHLAddress
Specifies the TCP/IP address of the storage agent. This value is used internally
in the SET STAHLADDRESS command that is inserted into the device
configuration file.
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SERVERName
Specifies the name of the Tivoli Storage Manager server. This name is
displayed in the DEFINE SERVER command that is inserted into the device
configuration file.

SERVERPAssword
Specifies the password of the server. This value is encrypted and is displayed
in the SERVERPASSWORD parameter of the DEFINE SERVER command that is
inserted into the device configuration file.

HLAddress
Specifies the TCP/IP address of the server. This value is used in the HLADDRESS
parameter of the DEFINE SERVER command.

LLAddress
Specifies the TCP/IP port on which to access the server. This value is used in
the LLADDRESS parameter of the DEFINE SERVER command.

SSL
Specifies whether the storage agent will use Secure Sockets Layer (SSL) for
communicating with the server. The default value is NO.

STAKEYDBPW
Specifies the password that is used to verify and control access to the SSL key
database. The value of the STAKEYDBPW parameter is stored in the storage agent
options file.

Examples

Issue the DSMSTA SETSTORAGESERVER command with the following information:
v Storage agent

Name: storagnt
Password: fun4me
TCP/IP address: agent.example.com

v Tivoli Storage Manager server
Name: tsmsrver
Password: not4u
TCP/IP address: tsmsrver.example.com
SSL port: 1542

The command is:
dsmsta setstorageserver myname=storagnt mypassword=fun4me
myhladdress=agent.example.com
servername=tsmsrver serverpassword=not4u

hladdress=tsmsrver.example.com lladdress=1502

The command generates the following lines in the device configuration file for the
storage agent:
set staname storagnt
set stapassword xxxxx
set stahladdress agent.example.com
define server tsmsrver serverpassword=xxxxxxxx

hladdress=tsmsrver.example.com lladdress=1502

The passwords (shown as xxxxxxxx) are encrypted in the file.
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The command also generates the following line in the dsmsta.opt file for the
storage agent:
servername tsmsrver

To enable SSL communication and to ensure that the storage agent is authenticated
through an LDAP directory server, issue the following command:
dsmsta setstorageserver myname=storagnt mypassword=fun4me
myhladdress=agent.example.com
servername=tsmsrver serverpassword=not4u
ssl=yes
stakeydbpw=password
hladdress=tsmsrver.example.com lladdress=1500
ssltcpport=1543

Related tasks:
“Installing the storage agent” on page 32
“Installing the storage agent” on page 54
“Installing the storage agent” on page 80

Tivoli Storage Manager device utilities
You can use device utilities for tasks that are related to configuring storage devices
for the Tivoli Storage Manager storage agent.

autoconf (Auto configure devices)
Use the autoconf utility to configure devices for use with the Tivoli Storage
Manager storage agent.

The autoconf utility performs the following tasks:
v Loads the driver to the kernel
v Creates the necessary files for the Tivoli Storage Manager device driver
v Creates device information files for libraries and tape devices

The autoconf utility is included in the device driver package and is installed to the
/opt/tivoli/tsm/devices/bin directory.

Options

/a Adds read and write permissions to Tivoli Storage Manager device files to
allow all users access to the devices. Specify this value to configure devices if
the Tivoli Storage Manager server is started by a non-root user.

/g Adds read and write permissions to the Tivoli Storage Manager device files to
allow anyone in the same group as a root user to use the devices.

/t Enables tracing for the autoconf utility.

/? Displays information about the autoconf utility and its parameters.

Example: Configure devices by using the autoconf utility

Run autoconf to configure Tivoli Storage Manager devices:
> /opt/tivoli/tsm/devices/bin/autoconf
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Appendix E. Tivoli support information

You can find support information for Tivoli and other IBM products from various
sources.

From the IBM Support Portal at http://www.ibm.com/support/entry/portal/, you
can select the products that you are interested in and search for a wide variety of
relevant information.

Communities and other learning resources
In addition to product documentation, many forms of assistance are available to
help you get started as you deploy and use the Tivoli Storage Manager family of
products. These resources can also help you to solve problems that you might
have.

You can use forums, wikis, and other social media tools to ask questions, talk to
experts, and learn from others.

User groups

Tivoli Global Storage Virtual User Group
Access this user group at http://www.tivoli-ug.org/storage.

This group makes it possible for individuals from many different industries
and types of organizations to share information and work directly with the
IBM product experts. Local chapters also exist where members meet in
person to share experiences and hear from guest speakers.

ADSM.ORG
Access this mailing list at http://adsm.org.

This independently managed Storage Management discussion forum
started when Tivoli Storage Manager was known as ADSTAR Distributed
Storage Manager (ADSM). The members of this forum have many years of
experience with Tivoli Storage Manager in almost every type of IT
environment.

To subscribe to the forum, send an email to listserv@vm.marist.edu. The
body of the message must contain the following text: SUBSCRIBE ADSM-L
your_first_name your_family_name.

Tivoli Storage Manager community on Service Management
Connect

Access Service Management Connect at http://www.ibm.com/developerworks/
servicemanagement. In the Storage Management community of Service
Management Connect, you can connect with IBM in the following ways:
v Become involved with transparent development, an ongoing, open engagement

between users and IBM developers of Tivoli products. You can access early
designs, sprint demonstrations, product roadmaps, and prerelease code.

v Connect one-on-one with the experts to collaborate and network about Tivoli
and the Tivoli Storage Manager community.

v Read blogs to benefit from the expertise and experience of others.
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v Use wikis and forums to collaborate with the broader user community.

Tivoli Storage Manager wiki on developerWorks®

Access this wiki at https://www.ibm.com/developerworks/servicemanagement/
sm/index.html.

Find the latest best practices, white papers, and links to videos and other
resources. When you log on, you can comment on content, or contribute your own
content.

Tivoli Support Technical Exchange

Find information about upcoming Tivoli Support Technical Exchange webcasts at
http://www.ibm.com/software/sysmgmt/products/support/supp_tech_exch.html.
Replays of previous webcasts are also available.

Learn from technical experts who share their knowledge and then answer your
questions. The sessions are designed to address specific technical issues and
provide in-depth but narrowly focused training.

Other social media sites

LinkedIn
You can join groups on LinkedIn, a social media site for professionals. For
example:
v Tivoli Storage Manager Professionals: http://www.linkedin.com/

groups/Tivoli-Storage-Manager-Professionals-54572
v TSM: http://www.linkedin.com/groups?gid=64540

Twitter
Follow @IBMStorage on Twitter to see the latest news about storage and
storage software from IBM.

Tivoli education resources

Use these education resources to help you increase your Tivoli Storage Manager
skills:

Tivoli Education and Certification website
View available education at http://www.ibm.com/software/tivoli/
education.

Use the Search for Training link to find local and online offerings of
instructor-led courses for Tivoli Storage Manager.

Education Assistant
Access resources at http://publib.boulder.ibm.com/infocenter/ieduasst/
tivv1r0/index.jsp.

Scroll to view the list of available training videos. Recorded product
demonstrations are also available on a YouTube channel.
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Searching knowledge bases
If a problem occurs while you are using one of the Tivoli Storage Manager family
of products, you can search several knowledge bases.

Begin by searching the Tivoli Storage Manager Information Center at
http://pic.dhe.ibm.com/infocenter/tsminfo/v7r1. Within the information center,
you can enter words, phrases, or message numbers in the Search field to find
relevant topics.

Searching the Internet
If you cannot find an answer to your question in the Tivoli Storage Manager
information center, search the Internet for the information that might help you
resolve the problem.

To search multiple Internet resources, go to the IBM support website at
http://www.ibm.com/support/entry/portal/. You can search for information
without signing in.

Sign in using your IBM ID and password if you want to customize the site based
on your product usage and information needs. If you do not already have an IBM
ID and password, click Sign in at the top of the page and follow the instructions
to register.

From the support website, you can search various resources:
v IBM technotes.
v IBM downloads.
v IBM Redbooks publications.
v IBM Authorized Program Analysis Reports (APARs). Select the product and click

Downloads to search the APAR list.

Using IBM Support Assistant
IBM Support Assistant is a complimentary software product that can help you with
problem determination. It is available for some Tivoli Storage Manager and Tivoli
Storage FlashCopy Manager products.

IBM Support Assistant helps you gather support information when you must open
a problem management record (PMR), which you can then use to track the
problem. The product-specific plug-in modules provide you with the following
resources:
v Support links
v Education links
v Ability to submit problem management reports

You can find more information and download the IBM Support Assistant web page
at http://www.ibm.com/software/support/isa.

You can also install the stand-alone IBM Support Assistant application on any
workstation. You can then enhance the application by installing product-specific
plug-in modules for the IBM products that you use. Find add-ons for specific
products at http://www.ibm.com/support/docview.wss?uid=swg27012689.
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Finding product fixes
A product fix to resolve a software problem might be available from the IBM
software support website.

Procedure

Determine what fixes are available by checking the IBM software support website
at http://www.ibm.com/support/entry/portal/.

If you previously customized the site based on your product usage:

1. Click the link for the product, or a component for which you want to
find a fix.

2. Click Downloads, and then click Search for recommended fixes.

If you have not previously customized the site:
Click Downloads and search for the product.

Receiving notification of product fixes
You can receive notifications about fixes, flashes, upgrades, and other news about
IBM products.

Procedure
1. From the support page at http://www.ibm.com/support/entry/portal/, click

Sign in and sign in using your IBM ID and password. If you do not have an
ID and password, click register now and complete the registration process.

2. Click Manage all my subscriptions in the Notifications pane.
3. Click the Subscribe tab, and then click Tivoli.
4. Select the products for which you want to receive notifications and click

Continue.
5. Specify your notification preferences and click Submit.

Contacting IBM Software Support
You can contact IBM Software Support if you have an active IBM subscription and
support contract, and if you are authorized to submit problems to IBM.

Procedure
1. Ensure that you have completed the following prerequisites:

a. Set up a subscription and support contract.
b. Determine the business impact of the problem.
c. Describe the problem and gather background information.

2. Follow the instructions in “Submitting the problem to IBM Software Support”
on page 116.
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Setting up and managing support contracts
You can set up and manage your Tivoli support contracts by enrolling in IBM
Passport Advantage. The type of support contract that you need depends on the
type of product you have.

Procedure

Enroll in IBM Passport Advantage in one of the following ways:
v Online: Go to the Passport Advantage website at http://www.ibm.com/

software/lotus/passportadvantage/, click How to enroll, and follow the
instructions.

v By telephone: For critical, system-down, or high-severity issues, you can call
1-800-IBMSERV (1-800-426-7378) in the United States. For the telephone number
to call in your country, go to the IBM Software Support Handbook web page at
http://www14.software.ibm.com/webapp/set2/sas/f/handbook/home.html
and click Contacts.

Determining the business impact
When you report a problem to IBM, you are asked to supply a severity level.
Therefore, you must understand and assess the business impact of the problem
you are reporting.

Severity level Description

Severity 1 Critical business impact: You are unable to use the program,
resulting in a critical impact on operations. This condition
requires an immediate solution.

Severity 2 Significant business impact: The program is usable but is
severely limited.

Severity 3 Some business impact: The program is usable with less
significant features (not critical to operations) unavailable.

Severity 4 Minimal business impact: The problem causes little impact on
operations, or a reasonable circumvention to the problem has
been implemented.

Describing the problem and gathering background information
When explaining a problem to IBM, it is helpful to be as specific as possible.
Include all relevant background information so that IBM Software Support
specialists can help you solve the problem efficiently.

To save time, know the answers to these questions:
v What software versions were you running when the problem occurred?
v Do you have logs, traces, and messages that are related to the problem

symptoms? IBM Software Support is likely to ask for this information.
v Can the problem be re-created? If so, what steps led to the failure?
v Have any changes been made to the system? For example, hardware, operating

system, networking software, and so on.
v Are you using a workaround for this problem? If so, be prepared to explain it

when you report the problem.
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Submitting the problem to IBM Software Support
You can submit the problem to IBM Software Support online or by telephone.

Online
Go to the IBM Software Support website at http://www.ibm.com/
support/entry/portal/Open_service_request/Software/
Software_support_(general). Sign in to access IBM Service Requests and
enter your information into the problem submission tool.

By telephone
For critical, system-down, or severity 1 issues, you can call 1-800-IBMSERV
(1-800-426-7378) in the United States. For the telephone number to call in
your country, go to the IBM Software Support Handbook web page at
http://www14.software.ibm.com/webapp/set2/sas/f/handbook/
home.html and click Contacts.
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Appendix F. Accessibility features for the Tivoli Storage
Manager product family

Accessibility features help users who have a disability, such as restricted mobility
or limited vision to use information technology products successfully.

Accessibility features

The IBM Tivoli Storage Manager family of products includes the following
accessibility features:
v Keyboard-only operation using standard operating-system conventions
v Interfaces that support assistive technology such as screen readers

The command-line interfaces of all products in the product family are accessible.

Tivoli Storage Manager Operations Center provides the following additional
accessibility features when you use it with a Mozilla Firefox browser on a
Microsoft Windows system:
v Screen magnifiers and content zooming
v High contrast mode

The Operations Center and the Tivoli Storage Manager Server can be installed in
console mode, which is accessible.

The Tivoli Storage Manager Information Center is enabled for accessibility. For
information center accessibility information, see “Accessibility features in the
information center” ( http://pic.dhe.ibm.com/infocenter/tsminfo/v7r1/topic/
com.ibm.help.ic.doc/iehs36_accessibility.html).

Vendor software

The Tivoli Storage Manager product family includes certain vendor software that is
not covered under the IBM license agreement. IBM makes no representation about
the accessibility features of these products. Contact the vendor for the accessibility
information about its products.

IBM and accessibility

See the IBM Human Ability and Accessibility Center (http://www.ibm.com/able)
for information about the commitment that IBM has to accessibility.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who want to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
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programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows: © (your company name) (year). Portions of
this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp.
_enter the year or years_.

If you are viewing this information in softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at "Copyright and
trademark information" at http://www.ibm.com/legal/copytrade.shtml.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

LTO and Ultrium and are trademarks of HP, IBM Corp. and Quantum in the U.S.
and other countries.

Microsoft and Windows are trademarks of Microsoft Corporation in the United
States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Privacy policy considerations
IBM Software products, including software as a service solutions, (“Software
Offerings”) may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings
can help enable you to collect personally identifiable information. If this Software
Offering uses cookies to collect personally identifiable information, specific
information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect
personally identifiable information.

If the configurations deployed for this Software Offering provide you as customer
the ability to collect personally identifiable information from end users via cookies
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and other technologies, you should seek your own legal advice about any laws
applicable to such data collection, including any requirements for notice and
consent.

For more information about the use of various technologies, including cookies, for
these purposes, see IBM’s Privacy Policy at http://www.ibm.com/privacy and
IBM’s Online Privacy Statement at http://www.ibm.com/privacy/details the
section entitled “Cookies, Web Beacons and Other Technologies” and the “IBM
Software Products and Software-as-a-Service Privacy Statement” at
http://www.ibm.com/software/info/product-privacy.
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Glossary

A glossary is available with terms and definitions for the IBM Tivoli Storage
Manager family of products.

You can view the glossary in the Tivoli Storage Manager information center at
http://pic.dhe.ibm.com/infocenter/tsminfo/v7r1.

To view glossaries for other IBM products, see http://www.ibm.com/software/
globalization/terminology/.
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